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This manual explains how to perform various operations that are enabled when you connect
an external device to the USB port of the XJ-S35 (Data Projector).

Terms and Conventions

In this manual, there are many procedures that require parallel operations on the Data
Projector and your computer. The following are special terms and conventions used in this
manual to differentiate between the Data Projector and computer.
* projection area
This is the entire rectangular area that is projected by the Data Projector. Certain Data
Projector operations will cause messages and menus to appear within the projection
area.
e computer screen
This is the physical display device of your computer.



The USB port that is built into the Data Projector lets you connect an external USB
device and use it as an input source for image projection.

USB Memory Device

You can connect a commercially available USB memory device to the USB port and
project images and movies stored on the device.

Refer to the following for details.

/ USB memory device \

| J

For more information about this:

Refer to this section of this manual:

Supported USB memory devices

“Supported USB Memory Devices” (page 14)

Supported image and movie file formats

“Supported Playback Data Types” (page 15)

Saving image data to a USB memory device

“Preparing a Presentation with EZ-Converter”
(page 15)

Projecting image and movie data from a USB
memory device

“Playing a Presentation with Viewer” (page 30)




Wireless Adapter (CASIO YW-2)

Establishing a connection between the Data Projector and a computer over a wireless LAN
makes it possible to project the display contents of the computer’s screen from the Data

Projector.

You can have up to four computers connected to the Data Projector over a wireless LAN
at the same time. Use the remote controller that comes with the Data Projector to select
which of the four computer screens you want to project.

Refer to the following for details.

For more information about this:

Refer to this section of this manual:

Supported wireless LAN devices

“Supported Wireless LAN Devices” (page 48)

Setup required to establish a wireless LAN
connection between the Data Projector and a
computer

“Wireless LAN Connection Basics” (page 52),
“Advanced Wireless LAN Connection Settings”
(page 65)

Projecting the screen contents of a computer
connected via a wireless LAN

“Using Wireless LAN for Projection” (page 91)




Document Camera (CASIO YC-400)

You can connect a CASIO YC-400 Document Camera to the Data Projector's USB port
and project the images of documents placed on the document stage of the YC-400.

For more information, see “Performing a Presentation Using the YC-400 Document Camera”
on page 96.



What happens when you connect a USB device to the Data Projector depends on the
current configuration of the Data Projector’'s plug-and-play setting. Plug-and-play is enabled
under the Data Projector’s initial default settings. For more details about the plug-and-play
setting, see “Setup Menu Contents” in the User’s Guide.

Turning On the Data Projector after Connecting a USB
Device

Normally when you turn on the Data Projector without a USB device connected, the Data
Projector will check the RGB terminal and then the VIDEO terminal for a signal. If it finds
a signal, the Data Projector will select it automatically and project the signal contents.

If you turn the Data Projector on while a USB device is connected to its USB port, it will
perform one of the following operations (depending on its current plug-and-play setting).

When plug-and-play is enabled:

When this type of

s The Data Projector does this automatically when turned on:
device is connected:

USB memory device Starts up Viewer (page 30) and projects the Viewer screen.

YW-2 Wireless Adapter Starts up Wireless (page 50) and projects the Wireless screen.
YC-400 Document Checks the RGB terminal and then the VIDEO terminal for an input
Camera signal. If it finds a signal, the Data Projector will select it automatically

and project the signal contents. Note that the YC-400 Document Camera
is not detected automatically.

When plug-and-play is disabled:

Turning on the Data Projector with a USB device connected while plug-and-play is disabled
will cause it to perform the same initial operation it performs when no device is connected.
That is, it checks the RGB terminal and then the VIDEO terminal for an input signal. If it
detects an input signal, the Data Projector will select it automatically and project the signal
contents. In this case, however, either Viewer or Wireless will start up in the background,
depending upon the type of USB device that is connected to the Data Projector.



Connecting to a USB Device while the Data Projector is
On

If you connect a USB device to the Data Projector's USB port while it is turned on, it will
perform one of the following operations (depending on its current plug-and-play setting).

When plug-and-play is enabled:

When this type of

s The Data Projector does this automatically:
device is connected:

USB memory device Starts up Viewer (page 30) and projects the Viewer screen.

YW-2 Wireless Adapter Starts up Wireless (page 50) and projects the Wireless screen.

YC-400 Document Starts up the YC Camera application (page 96) when the YC-400
Camera Document Camera is turned on and projects the YC Camera application
screen.

When plug-and-play is disabled:

In this case, the image that is currently being projected does not change. However, Viewer,
Wireless, or the YC Camera Application will start up in the background, depending upon
the type of USB device that is connected to the Data Projector.

Changing the Input Source while a USB Device is
Connected

On the Data Projector’s remote controller, press the [INPUT] key to change the input
source. Each time you press the [INPUT] key, the Data Projector will check the RGB
terminal, VIDEO terminal, and USB port for an input signal. If it finds a signal, it will
select it as the input source automatically and project its contents.



Use the procedures in this section to install the software that comes bundled with the
Data Projector onto your computer.

When you want to do this: Install this software:

Convert files created with PowerPoint to image (JPEG) files and store EZ-Converter
them on a USB memory device

Send computer screen contents to the Data Projector over a wireless Wireless Connection
connection and project them

Minimum System Requirements

The following describes minimum computer system requirements to run the bundled
software.

* Operating System:Microsoﬂ® Windows® XP or 2000 Professional

e Computer: IBM PC/AT or compatible that conforms to the following conditions.

Windows® XP or 2000 Professional pre-installed

PowerPoint 2000, 2002, or 2003 installed (to use EZ-Converter)

CPU: Pentium Il or higher

USB port (Type A, USB1.1/2.0)

Memory: 256 MB minimum or amount of memory recommended for operating system
being run

Hard Disk: At least 40 MB for installation or at least 60 MB when running

Display: Full-color display with resolution of at least 800 x 600 that is supported by
above operating systems and the computer being used.

Pointing Device: Mouse or other equivalent device supported by above operating

systems.

Keyboard

CD-ROM drive

Other requirements of operating system being used

* Normal operation may not be possible under certain hardware configurations.

* Operation is not supported on a computer running Windows® NT, Me, 98SE, 98, 95, or
3.1, or on a Macintosh or Mac OS computer.

* QOperation on a computer upgraded to Windows® XP, 2000 Professional from another
operating system is not supported.

¢ Operation on a computer running Windows® XP Professional x64 Edition is not
supported.
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To install software

1 Place the bundled CD-ROM into your computer’s CD-ROM drive.
® This displays the dialog box shown below.

Install %]

The following soMtware will be installed.

W EZ-Camverter

¥ Wireless Connection

Select the check box of the software you want to install.

Click the [Install] button.
® This will start installation.

WnN

Keep clicking the [Next] button on the dialog boxes that appear.

® If your computer is running Windows XP and the dialog box shown below appears, click
the [Continue Anyway] button.

Software Installation

1} The software pou are inctaling has ot patsed Windows Logo
= testing lo vesty its with Windows XP. (Tell me why
this tesling is important |

Continuing pour inztallation of this software may impais
ot destabilize the conect opesation of your system
wither immediately or in the future. Miciozoft slrongly
recommends that you stop this installation now and
contact the software vendor for software that has
pazzed Windows Logo testing.

[ Contrms Arpway | [[STOP Instalaon |

® |f your computer is running Windows 2000 and the message “The software you are
about to install does not contain a Microsoft digital signature.” appears, click the [Yes]
button.

12



® The dialog box shown below will appear after installation is complete.

InstaltShield Wizard

InstaltShield Wizard Complete

Addupter Drreer, Chck Frash b o the vazasd

5 Click the [Finish] button.
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Memory Device

This section explains how to perform the following operations.

® Using the bundled EZ-Converter software to save a presentation file to a USB memory
device

® Connecting a USB memory device to the Data Projector and using Viewer to project image
or movie data contained on the device

Important!

In order to perform the procedures in this section, you will first need to install the EZ-
Converter software from the bundled CD-ROM onto your computer. For more information,
see “Installing Data Projector Software” (page 11).

Supported USB Memory Devices

The Data Projector supports connection of the following types of FAT/FAT32 format USB

memory devices.

® USB memory

® USB Mass Storage Class compatible digital cameras

® USB Mass Storage Class compatible hard disk drives (excluding types that require power
supply from the USB port)

For details about supported USB memory devices (products whose operation has been

confirmed), see the CASIO website at http://world.casio.com/projector/support/en/.
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Supported Playback Data Types

The image data types listed below can be played back using the Data Projector's Viewer.
® JPEG format (jpg, jpeg, jpe) and BMP format (bmp) image files
* Playback of image files of approximately 6 Mbytes is supported.
* Progressive JPEG image files are not supported.
® MP4 format (mp4) movie files and AVI format (avi) movie files recorded with a CASIO
digital camera
For details about movie files supported for playback by the Data Projector and playback
specifications, visit the CASIO website at: http://world.casio.com/projector/support/en.

Preparing a Presentation with EZ-Converter

EZ-Converter is software that runs on a Windows computer. You can use EZ-Converter to
convert a file (ppt) created with Microsoft PowerPoint to presentation data that can be played
back using the Data Projector’s Viewer feature.

Following conversion the presentation data can be stored on a USB memory device, which
can then be connected to the Data Projector for the presentation.

Note that the conversion process may result in some differences between the original
PowerPoint file and the resulting presentation data.

Presentation Data

The presentation data produced by EZ-Converter consists of presentation (plf) files and
image (jpg) files. When you convert a PowerPoint file that includes 10 pages of data, EZ-
Converter will create 10 image (jpg) files and one presentation (plf) file that is linked to
the image files. The presentation file will contain information about the sequence that the
10 image files should be projected, along with other playback settings.

"""" | Presentation Data I

Presentation File
* Image file information
* Presentation playback setting information

XXX.plf

Image File Image File Image File Image File Image File

XXX-001jpg  XXX-002jpg  XXX-003jpg  XXX-004.jpg XXX-010.jpg




Main EZ-Converter Functions

PowerPoint File Conversion

* Conversion of PowerPoint files up to 500 pages in size

* Support for files created using PowerPoint 2000, 2002, 2003 for Windows
» Editing of converted presentation data with EZ-Converter

%@ Important!

PowerPoint file animations are not supported. The image transition effect used is the
one specified by the EZ-Converter presentation file.

Adding Image Files Directly to Presentation Files

In addition to converting PowerPoint pages to image files, you can also add individual

image files directly to presentation data.

* You can add up to 500 JPEG format or BMP format image files directly to presentation
data.

Starting Up and Exiting EZ-Converter

To start up EZ-Converter

On your computer's Windows Start menu, select [All Programs] - [CASIO] - [EZ-Converter].
This will cause the EZ-Converter window shown below to appear.

"% EZ-Converter
Fie Edt Tocls Help
= B | B &

|

The above window indicates that there is no presentation data currently open. This is what
we call an “empty” EZ-Converter window.

%O) Important!

In order to start up EZ-Converter, PowerPoint 2000, 2002, or 2003 will need to be
installed on the computer.

To exit EZ-Converter
On the [File] menu, select [Exit].



Creating New Presentation Data

There are two ways that you can use EZ-Converter to create new presentation data: by
converting a PowerPoint file (see below) or by inserting image files into the presentation
data manually (page 19).

Creating Presentation Data by Converting a PowerPoint
File
This procedure creates presentation data that includes all of the pages of the PowerPoint

file. In order to perform this procedure, you will first need to prepare the PowerPoint file
that you want to convert.

To create presentation data by converting a PowerPoint File

Start up EZ-Converter.
® This will display the empty EZ-Converter window.

® |f EZ-Converter is already running on your computer and if there is already presentation
data in the EZ-Converter window, click # to clear the data from the EZ-Converter
window.

2 Configure presentation options as required.
® For more information, see “Configuring the Option Setting” (page 20).

3 Either click % or select [Convert PowerPoint File] on the [File] menu.
® This displays a dialog box for selecting PowerPoint files.

Selects a PowerPoint file. [z|
Loak in: |.,'_] My Documnents :J & ek E-

My eBaoks
,ﬂMy Music
ﬁMy Pictures

Fierane: |
Files of type:  [PowerPeint Fie ["ppl) =] cencel |




4 Select the PowerPoint file you want to convert and then click [Open].

® This starts conversion of the PowerPoint file, which is indicated by the appearance of a
dialog box that shows the progress of the conversion.

Converting PowerPoint file...

23 %

® After conversion is complete, the EZ-Converter widow will reappear with thumbnails of the
converted images.

"Rt EZ-Converter - [ Mat_01.plf ] .
Fle Edt Joos Help " Selected image number
e 5 . .
(from beginning)
B B R A R mw',

Total number of files

2003

1967 - 2042 5 (
Sl

17— Image file display area

-
1988 - 2076

Add, delete, move, and otherwise edit the images as required.
® For details, see “Editing Presentation Data” (page 21).

Configure presentation playback settings.
® For more information, see “Configuring Presentation Data Playback Settings” (page 23).

To save the presentation data, click the [Save] button.
® For details, see “Saving Presentation Data” (page 26).
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% Note

® Instead of steps 3 and 4 of the above procedure, you could also drop a single
PowerPoint file into the EZ-Converter window.

L 7 Convertar ey ]

—
i
PN

i B B
Mat_01 pok

® Converting a PowerPoint file to presentation data will generate the following folder,
image files and presentation file.
Example: When converting a 50-page PowerPoint file named “MeetingDocuments”

[:___4 MeetingDocuments (Folder)

MeetingDocuments.plf < Presentation file
MeetingDocuments001.jpg
MeetingDocuments002.jpg
MeetingDocuments003.jpg Image files

MeetingDocuments050.jpg

Creating Presentation Data by Inserting Image Files
Manually
You can create new presentation data by dropping multiple image (jpg or bmp) files into

the EZ-Converter window. In order to perform this procedure, you will first need to prepare
the image files that you want to include in the presentation data.

To create presentation data by inserting image files manually

Start up EZ-Converter.
® This will display the empty EZ-Converter window.

® |f EZ-Converter is already running on your computer and if there is already presentation
data in the EZ-Converter window, click # to clear the data from the EZ-Converter
window.

Use Windows Explorer to select all of the image files you want to include in the
presentation data.



3 Drag the selected files into the EZ-Converter window.

. Com S| 8 ey pictoes

Fla Gl Vew Favortes Tock b

B M e B - ¥ P

® This will insert the image files into the presentation data and display their thumbnails in
the EZ-Converter window.

Add, delete, move, and otherwise edit the images as required.
® For details, see “Editing Presentation Data” (page 21).

Configure presentation playback settings.
® For more information, see “Configuring Presentation Data Playback Settings” (page 23).

To save the presentation data, click the [Save] button.
® For details, see “Saving Presentation Data” (page 26).

Configuring the Option Setting

You can use option settings to specify the resolution of image files that are saved as EZ-
Converter presentation data.

Important!

Any changes you make to image settings using the procedure below will go into effect
the next time you convert a PowerPoint file. Changed settings are not applied to
presentation data that has already been created by converting PowerPoint files. Note
that you cannot change the resolution of image data that is included in existing
presentation data.

To configure the option setting

On the [Tools] menu, select [Options].
® This will display a dialog box for configuring the option setting.

Options g|

Corwert Power Paink File

" High-qualty

% Maimal-quality

Cancel |
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2 Configure the setting on the dialog box as described below.

When you want to do this when converting a PowerPoint file

to presentation data: SR 5 ST

Save image files as high-quality JPEG files [High-quality]

Save image files as higher compression JPEG files [Normal-quality]

After selecting the setting you want, click the [OK] button.
® This will apply the setting and close the dialog box.

Editing Presentation Data

After you create presentation data by converting a PowerPoint file or by inserting image
files manually, you can add, delete, and change the positions of image files as required.
Before performing the procedures here, you will need to display the EZ-Converter window
that contains the presentation data that you want to edit. For details about how to do this,
see “Creating New Presentation Data” (page 17) and “Opening Presentation Data”

(page 28).

To add image files to presentation data

1 On the EZ-Converter window, click the thumbnail of the image that will come
either before or after the image you are about to add.

2 Use Windows Explorer to select the image file you want to add to the
presentation data.
® You can select one or more image files.

Drag the selected files into the EZ-Converter window.

® |f you want the image file(s) to be inserted immediately following the image you selected
in step 1, simply drop the image file(s) into the EZ-Converter window. If you want the
image file(s) to be inserted in front of the selected image, hold down your computer’s
[Ctrl] key as you drop the image file(s) into the window.

® This will add the image file(s) and update the thumbnails in the EZ-Converter window.



% Note

Instead of steps 2 and 3 of the above procedure, you could click & or you could
select [Add Image to Presentation File] on the [Edit] menu. Then on the dialog box that
appears, select one image file that you want to add to the presentation data. This will
insert the image file into the presentation data immediately following the image you
selected in step 1, above.

To delete an image file from presentation data

On the EZ-Converter window, click the thumbnail of the image you want to
delete so it is selected.

Either click [ or select [Delete Image from Presentation File] on the [Edit]
menu.

® This will delete the selected image.

® |n place of step 2, you could also press the [Delete] key on your computer keyboard.

% Note

Deleting an image file from the presentation data does not delete the image data file
from your computer’s hard disk.

To move an image file forward or back within presentation data

1 On the EZ-Converter window, click the thumbnail of the image you want to move
so it is selected.

2 To move the selected image one position to the left (towards the beginning),
click & or select [Move Image Back] on the [Edit] menu. To move the image
one position to the right (towards the end), click or select [Move Image
Forward] on the [Edit] menu.

To undo an image operation

Select [Undo] on the [Edit] menu, or press [Ctrl]] + [z] on your computer keyboard.
You can use the above operation to undo the last image file add, delete, or move
operation you performed.



Configuring Presentation Data Playback Settings

You can configure the following playback settings for playback of EZ-Converter presentation
data with the Data Projector’s Viewer.

* Manual or auto image change

* Display time of each image file during auto image change

* Repeat play on/off

* Image transition effect

% Note

The playback settings you configure are stored in the presentation (plf) file.

To configure presentation data playback settings

On the EZ-Converter window, display the presentation data whose playback
settings you want to configure.

® For details about how to do this, see “Creating New Presentation Data” (page 17) and
“Opening Presentation Data” (page 28).

Click 5&, or select [Presentation File Setup] on the [Tools] menu.
® This displays a dialog box for configuring presentation file settings.

Presentation File Setup
Display Interval

* Marual

" Auto

Fepeat

" On
& 0l

Image Transition Effect

€ 0n  [Sideln CeitioFigh -]

& Off

coct_|
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Configure the following settings on the dialog box.

When you want to do this:

Do this:

Change images manually during a
presentation

Select [Manual] for [Display Interval].

Have images change automatically during a
presentation

Select [Auto] for [Display Interval].

Specify the display interval during auto image

change

® This setting is available only while [Auto]
is selected for [Display Interval].

Tap the down arrow button of the box under
[Display Interval] and select an interval value
(5 seconds, 10 seconds, 30 seconds,

1 minute, and 5 minutes).

Have the presentation restart from the
beginning after the final image file is reached

Select [On] under [Repeat].

Have the presentation stop after the final
image is reached.

Select [Off] under [Repeat].

Turn off the image transition effect

Select [Off] under [Image Transition Effect].

Turn on the image transition effect

Select [On] under [Image Transition Effect].

Specify the effect to be applied when

transitioning from one image file to the next

® This setting is available only while [On] is
selected for [Image Transition Effect].

Click the down arrow button of the box

under [Image Transition Effect] and select an

effect.

® For details, see “Image Transition Effects”
(page 25).

4 After configuring all the settings you want, click the [OK] button.




Image Transition Effects

When “On” is selected for the “Image Transition Effect” setting on the “Presentation File
Setup” dialog box, you can select a visual effect to be applied any time you transition
from one image file to another. The following shows examples of each of the available
effects.

Effect Name Example

Slide In - Left to Right

Slide In - Right to Left

Slide In - Top to Bottom

Slide In - Bottom to Top

Wipe - Left to Right

Wipe - Right to Left

Wipe - Top to Bottom

Wipe - Bottom to Top

Dissolve

>>>>>:>>>>>
I o Il o
EEEEEEREEE

% Note

For information about performing a presentation using playback settings that are different
from those that were stored with presentation data using EZ-converter, see “Configuring
Viewer Setup Menu Settings” (page 42).

25



Saving Presentation Data

Use the procedures in this section to save presentation data to a USB memory device or
to your computer’s hard disk.

To save presentation data to a new file
1 Perform the procedure under “Creating New Presentation Data” (page 17).

If you want to save the presentation data to a USB memory device, connect the

device to your computer’s USB port.

® For details about how to connect a USB device, see the user documentation that comes
with your computer and the USB memory device you are using.

Click == | or select [Save Presentation File As] on the [File] menu.
® This will display a dialog box for specifying a file name.

Input the name you want to sssign to the presentation
file you are saving.

[ew Presertation Fig

ot |

® |f you are saving presentation data produced by converting a PowerPoint file, the name
of the PowerPoint file will be inserted in the dialog box automatically. In other cases,
“New Presentation File” will be displayed in the dialog box.

4 Enter the file name you want and then click the [OK] button.
® This will display a dialog box for specifying the location where you want to store the file.

5 Specify the location where you want to store the file and then click the [OK]

button.

® This will create a folder with the name you specified in step 4 and store the
presentation data in the folder.

® |f there is already a folder with the same name as the one you specified at the location
you specified, a confirmation message will appear asking if you want to replace the
existing folder with the new one. If you do, click [Yes] on the dialog box. If you do not
want to replace the existing folder with the new one, click [No]. This will return to the
dialog box in step 3 of this procedure so you can enter a different name.



% Note

Performing this procedure will generate the presentation files shown below.
Example:When you input the folder name “Market Data 2006” for a 50-image
presentation

[} Market Data 2006 (Folder)

Market Data 2006.plf +— Presentation file
Market Data 2006 001.jpg

Market Data 2006 002.jpg

Market Data 2006 003.jpg Image files

Market Data 2006 050.jpg

To overwrite existing presentation data with newly edited data

Perform the procedure under “Editing Presentation Data” (page 21) or
“Configuring Presentation Data Playback Settings” (page 23).

Click H or select [Save Presentation File] on the [File] menu.
® This saves the existing presentation data with the edited data.

To save existing presentation data under a different name

On the EZ-Converter window, display the presentation data you want to save
under a different name.

Click == | or select [Save Presentation File As] on the [File] menu.
® This will display a dialog box for specifying a file name.

Input the name you want to assign ta the presentation
file you are saving.

ot |

® For the remainder of this procedure, perform the steps starting from step 4 under “To
save presentation data to a new file” (page 26).



Opening Presentation Data

Use the procedure below to open existing presentation data in order to edit it or to save it
under a different name.

% Note

To open presentation data, specify a presentation file (plf).

To open a presentation file

1 If the presentation data you want to open is stored on a USB memory device,
connect the device to your computer’s USB port.

2 Click [=; or select [Open Presentation File] on the [File] menu.
® This displays a dialog box for opening presentation files.

Select the presentation (plf) file you want to open and then click [Open].
® This will open the presentation file and display the EZ-Converter window.

Viewing Help

To view EZ-Converter help, select [Help] on the [Help] menu.

Viewing Version Information

To view EZ-Converter version information, select [About EZ-Converter...] on the [Help]
menu.



EZ-Converter Menu and Button Reference

This section provides detailed information about the EZ-Converter menu commands and about

the buttons that appear on the EZ-Converter window.

To do this:

Perform this menu
operation:

Or click
this button:

Convert a PowerPoint file to presentation data and display it
in the EZ-Converter window

[File] - [Convert
PowerPoint File]

&

Clear presentation data currently in the EZ-Converter window [File] - [C.Iear . )
Presentation File]
Open an existing presentation (plf) file and display its [File] - [Open

contents in the EZ-Converter window

Presentation File]

Save the presentation data currently in the EZ-Converter

=

window to an existing file, which overwrites the current [File] - [S.ave ) B
- ! Presentation File]

contents of the existing file
Save the presentation data currently in the EZ-Converter [File] - [Save s
window to a new file Presentation File As]
Save the presentation data currently in the EZ-Converter [File] - [Save s
window under a different name Presentation File As]
Exit EZ-Converter [File] - [Exit] -
Undo the last editing operation you performed on the EZ- [Edit] - [Undo] B

Converter window

Add an image file to the presentation data currently in the
EZ-Converter window

[Edit] - [Add Image
to Presentation File]

Delete an image file from the presentation data currently in
the EZ-Converter window

[Edit] - [Delete
Image from
Presentation File]

Move an image file in the presentation data currently in the
EZ-Converter window one position to the left (towards the
beginning)

[Edit] - [Move Image
Back]

Move an image file in the presentation data currently in the
EZ-Converter window one position to the right (towards the
end)

[Edit] - [Move Image
Forward]

Configure playback settings of the presentation data currently
in the EZ-Converter window

[Tools] -
[Presentation File
Setup]

Specify the resolution and size of image files that are saved
as EZ-Converter presentation data

[Tools] - [Options]

Display EZ-Converter help

[Help] - [Help]

Display EZ-Converter version information

[Help] - [About EZ-
Converter...]




Playing a Presentation with Viewer

Viewer is an application built into the Data Projector that lets you display image files and
play back movie files that are stored on a USB memory device that is connected to the
Data Projector. Viewer starts up automatically whenever you connect a supported USB

memory device (see “Supported USB Memory Devices” on page 14) to the Data Projector’s
USB port.

% Note

All of the operations in this section are performed using the Data Projector’s remote
controller keys or the Data Projector’s keys.

To connect a USB memory device to the Data Projector

Turn on the Data Projector.
® Wait until the Data Projector's POWER/STANDBY indicator is lit green.

Plug the USB memory device that contains the data you want to project with
Viewer into the Data Projector’s USB port.

® Once the Data Projector recognizes the USB memory device, Viewer will start up
automatically and a menu of the files contained on the USB memory device will be
projected in the projection area.
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% Note

® Viewer will not start up automatically if the Data Projector’s plug-and-play feature is
turned off. In this case, you will need to press the [INPUT] key to switch the input
source to the USB memory device. For more details about the plug-and-play setting,
see “Setup Menu Contents” in the User's Guide.

® Only files of formats that are recognized by the Data Projector (jpg, jpeg, jpe, bmp,
avi, mp4) appear in the file menu. Note that even if a file appears in the file menu,
it does not mean that the file can be displayed or played back by the Data Projector.

® The file menu displays USB memory device contents in the following sequence:
folders, movie files, image files. For details about how to play back a movie file, see
“Using Viewer to Play a Movie” (page 40).

File Menu Operations

When Viewer starts up, it initially projects a menu of files contained on the USB memory
device. There are two different views for the file menu: a thumbnail view and a tree view.

OoOoono
OoOoonon

Thumbnail View Tree View

Thumbnail View
This view shows thumbnails of the image files and movie files contained on the USB

memory device. Folders are shown as icons.

% Note

A question mark (?) in place of a thumbnail indicates an image file that cannot be
displayed by Viewer for some reason.

Tree View
This view shows a Windows Explorer type tree representation of the folders, image files,

and movie files on the USB memory device.

31



To switch between the thumbnail view and the tree view

1 Press the [FUNC] key.
® This displays the Viewer function menu shown below.

View Presentation List
Display Image

Screen Format

Return to previously displayed image.
(' Start Slideshow
A Previous Screen
O : Next Screen

2 Use the [¥] key to move the highlighting to “Screen Format” and then press
the [ENTER] key.

® This toggles between the thumbnail view and the tree view

To scroll file menu pages

To scroll to the next menu page press the [[J] key. To scroll back to the previous page,
press the [A] key.

% Note

Arrow indicators appear on right side of the file menu to indicate that there are more
files above (.4%.) or below (") the current screen. Press the [[J] key to scroll down
when %7 is indicated, or [A] key when <. is indicated.
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To select a file or a folder

Thumbnail View
Use the cursor keys to move the highlighting to the file or folder you want to select.

Highlighting

Tree View
Use the [A] and [V¥] cursor keys to move the highlighting to the file or folder you want to
select.

Highlighting
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To open a folder

1 Use the cursor keys to select the file you want to open.

Press the [ENTER] key.
® This opens the selected folder and displays a menu of its contents.
® With the tree view, you could also press the [P] key instead of the [ENTER] key.

To close the current folder and move up to the next level

Thumbnail View
Press the [ESC] key.

Tree View

Press the [ESC] key or the [d] key. This will collapse the folder where the highlighting is
currently located and move the highlighting to the next higher level.

To select a file menu item and display its image

1 Use the cursor keys to select the file whose image you want to display.

2 Press the [ENTER] key.
® This will display a full-size version of the image that fills the projection area.

3 To return to the file menu, press the [ESC] key.

% Note

® If the selected file is too large to fit within the projection area, the message “Cannot
display an image file” will appear.

® For information about operations you can perform while the image of a file is being
projected, see “Operations during Image File Content Projection” (page 38).

To start a slideshow from a particular image file

Use the cursor keys to select the file whose image from which you want to
start the slideshow.

Press the [O] key.

® This will display a full-size version of the image that fills the projection area. Now the
Data Projector will advance to the next image automatically at a regular interval (default:
5 seconds).

® If “Manual” is selected for the “Image Switching” setting, the image will not change
automatically. In this case, press the [P] key to advance to the next image.

3 To stop the slideshow and return to the file menu, press the [ESC] key.



% Note

® A slideshow displays the image files (jpg or bmp) that are included in the same
folder as the image file you select in step 1 of the above procedure. All other files
are ignored.

® For details about operations you can perform during a slideshow, see “Operations
during a Slideshow” (page 39).

® For information about how you can specify the interval between images, image
transition effects, and other playback settings, see “Configuring Viewer Setup Menu
Settings” (page 42).

® A slideshow that uses presentation data created with EZ-Converter will be played
back in accordance with the playback settings included in the presentation data. For
details, see “Configuring Presentation Data Playback Settings” (page 23).

To move the highlighting to the previously projected image file

While the thumbnail view or tree view is being projected, press the [FUNC] key.
® This will display the Viewer function menu.

[=] Viewer Functions
Yiew Presentation List
Display Image
Screen Format
Return to previously displayed image.
O : Start Slideshow
At Previous Screen
[ : Next Screen

I [al/[¥]:Select [ENTER] :0K [ESC] :Quit I

Use the [V¥] key to move the highlighting to “Return to previously displayed
image.” and then press the [ENTER] key.

® This returns to the image file that was projected immediately before the last projected
file.

% Note

This function comes in handy in the following cases.

® To return the highlighting to the last projected image file after projecting a movie file.

® To return the highlighting to the image where a slideshow was paused in order to
project a movie file.
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Using the Presentation Menu

The folder that contains the presentation file created using the EZ-Converter software (page
15) that comes bundled with the Data Projector is called a “presentation folder”.
Presentation folders appear along with other folders on the Viewer file menu, and they are
indistinguishable from other folders. Because of this, Viewer also provides a “presentation
menu” that makes it easy to find all of the presentation folders that are included on a

USB memory device.

To view the presentation menu

While the Viewer file menu is shown, press the [FUNC] key.
® This displays the Viewer function menu shown below.

View Presentation List
Display Image
Sereen Format

Return to previously displayed image.

(- Start Slideshow
A Previous Screen
[ : Next Screen

2 Check to make sure that “View Presentation List” is selected and then press the
[ENTER] key.
® This displays a presentation menu like the one shown below.

Thumbnail of first image
file in presentation

Presentation file menu

Presentation properties

Presentation path
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To perform a slideshow by running a presentation file

Use the [¥] and [A] keys to move the highlighting to the presentation file you
want to run.

2 Press the [ENTER] key or the [O] key.
® This will start the currently selected presentation file.
® The image file sequence, display time for each image, and image transition effect will all
be in accordance with the settings stored in the presentation file. For more information,
see “Configuring Presentation Data Playback Settings” on page 23.

3 To stop the slideshow, press the [ESC] key.

% Note

® The file menu (not the presentation menu) will reappear after the slideshow stops
when you press the [ESC] key or after it stops automatically.

® For details about operations you can perform during a slideshow, see “Operations
during a Slideshow” (page 39).

To return to the file menu from the presentation menu
Press the [ESC] key.



Operations during Image File Content Projection

To scroll between image files
Use the [P] and [4] keys.

To do this: Press this key:
Display the content of the next image file Lgl
Display the content of the previous image file (4]

% Note

Scrolling to a file that is too large to fit within the projection area will cause the
message “Cannot display an image file.” to appear.

To rotate an image
Use the [A] and [V¥] keys.

To do this: Press this key:
Rotate the image 90 degrees right [A]
Rotate the image 90 degrees left [V¥]

% Note

You can also rotate an image by pressing the [FUNC] key to display the Viewer
function menu. Move the highlighting to “Rotate Right” or “Rotate Left” and then press
the [ENTER] key.

‘iewer Functions

Rotate Risht |
| Rotate Left |

2 Start Slideshow
[A]/[%]:Select [ENTER]:OK [ESC] :Quit

To start a slideshow from the currently displayed image file content
Press the [O] key.

% Note

You can also start a slideshow from the currently displayed image file content by
pressing the [FUNC] key to display the Viewer function menu. Move the highlighting to
“Start Slideshow” and then press the [ENTER] key.

To return to the file menu from image file content
Press the [ESC] key.
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Operations during a Slideshow

To pause a slideshow while auto image change is turned on
Press the [[J] key.

To unpause a slideshow while auto image change is turned on
Press the [O] key.

To scroll between image files during a slideshow
Use the cursor keys.

To do this: Press this key:
Scroll to the content of the next image file »]
Scroll to the content of the previous image file (4]

% Note

After scrolling to an image file, the slideshow will scroll to the next image file
automatically after the preset time interval if “Auto” is selected for the “Image Switching”
setting. Note, however, that this is not true while the slideshow is paused.

To stop a slideshow and return to the file menu
Press the [ESC] key.



Slideshow Start Error

The error message shown below may appear when you attempt to start a slideshow using
one of the procedures under “To start a slideshow from a particular image file” (page 34),
“To perform a slideshow by running a presentation file” (page 37), or “To start a slideshow
from the currently displayed image file content” (page 38).

There is a problem with the slideshow setup file. Cannot start the slideshow. |

If this happens, use EZ-Converter to create a new presentation file and store it on the
USB memory device. Next, use the new presentation file to run the slideshow.

Using Viewer to Play a Movie

This section explains procedures you can use to play a movie using Viewer.

To play a movie file

On the file menu, select the movie file you want to play.

® For information about how to select a particular file on the file menu, see “To select a
file or a folder” (page 33).

2 Press the [ENTER] key.
® This will start playback of the selected movie file.

3 To stop movie playback and return to the file menu, press the [ESC] key.

% Note

Pressing the [ENTER] key while a file whose playback is not supported by the Data
Projector is selected will cause the error message “This movie file cannot be played
back” to appear. For more information, see “Supported Playback Data Types” (page 15).



Operations during Movie File Playback
You can perform the operations described below during movie file playback.

To do this:

Perform this operation:

Pause movie playback

Press the [ENTER] key.
To restart movie playback after it has been pause, press the
[ENTER] key again.

Fast reverse

Press the [4] key.

Fast forward

Press the [P] key.

Stop movie playback

Press the [ESC] key.

Jump to the beginning of the
currently playing movie file
and pause there

1. Press the [FUNC] key to display the viewer function menu.
® “Jump to Beginning” should be selected by default.
2. Press the [ENTER] key.

Jump to the end of the
currently playing movie file
and pause there

-

. Press the [FUNC] key to display the viewer function menu.
2. Use the [¥] key to move the highlighting to “Jump to End” and
then press the [ENTER] key.

Skip to the beginning of the
next movie file (on the file
menu) and pause there

-

. Press the [FUNC] key to display the viewer function menu.
2. Use the [¥] key to move the highlighting to “Skip to Next
Movie” and then press the [ENTER] key.

Skip to the beginning of the
previous movie file (on the
file menu) and pause there

-

. Press the [FUNC] key to display the viewer function menu.
2. Use the [¥] key to move the highlighting to “Skip to Previous
Movie” and then press the [ENTER] key.

Turn display of the playback
time on and off

Press the [(O] key or perform the following steps.

1. Press the [FUNC] key to display the viewer function menu.

2. Use the [¥] key to move the highlighting to “Time Indicator
On/Off” and then press the [ENTER] key.

% Note

Pressing the [FUNC] key during movie playback will pause playback and display the
Viewer function menu. Playback will resume when you press the [ESC] key to close the

Viewer function menu.




Configuring Viewer Setup Menu Settings

You can use the Viewer Setup Menu to configure viewer display settings and to perform a
presentation using playback settings that are different from those that were stored with
presentation data using EZ-Converter.

P
Yiewer Setup
Image Zoom @ Zoom ONo Zoom
Display Sequence Setup File Mames (Ascending ) Modify [ENTER]
Startup Mode @ Thumbnails OTree
Image Switching @Manual OAuto
Slideshow Display Interval 5 seconds Modify [ENTER
Slideshow Transition Effect Slide In - Left to Right Madify [ENTER]
Slideshow Repeat Q0n @0ff
Movie Display Zoom Madify [ENTER]
Initialize Yiewer Setup OK [ENTER]
[A/LV]:Select [41/L»]: Modify LESC]:Quit

% Note

® When you perform a slideshow by running a presentation file created with EZ-
Converter, the slideshow settings on the Viewer setup menu (Image Switching,
Slideshow Display Interval, Slideshow Transition Effect, and Slideshow Repeat) are
changed automatically to the playback settings (page 23) saved in the presentation file
you are running.

® |n order to modify slideshow settings for which “Auto” was selected for the
presentation file’s “Image Switching” setting when the file was created with EZ-
Converter, you need to pause the slideshow, open the menu, and then change the
settings as required.

To configure Viewer setup menu settings

1 Press the [MENU] key to display the setup menu.

2 Press the [¥] key to move the highlighting to “USB” and then press the
[ENTER] key.

3 Press the [¥] key once to move the highlighting to “Setup” and then press the
[ENTER] key.
® This will display the Viewer setup menu.

4 Use [¥] and [A] to select the menu item whose setting you want to change.
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5 What you should do next depends on whether or not [ENTER] is displayed at
the far right of the setting you are configuring (the one that is highlighted).

If [ENTER] is displayed:
a. Press the [ENTER] key.
b. On the submenu that appears, use [¥] and [A] to move the highlighting to the setting
you want to select.
Example: The following is the submenu that appears when “Display Sequence Setup” is
selected in step 2, above.

[Ex] Display Sequence Setup
@ File Names {Ascending)
O File Names {Descending}

O Time {New-to-01d}
O Time {Dld-to-New)

[al/[w]:Select [ENTER]:OK [ESC] :Quit

c. Press the [ENTER] key.
® This will return to the Viewer setup menu.

If [ENTER] is not displayed:
Press the [«] or [P] key to select the setting you want (so its button is @).

6 Repeat steps 4 and 5 to configure other settings, if you want.
7 After all the settings are the way you want, press the [MENU] key to exit the

Viewer setup menu.

To restore all settings on the Viewer setup menu to their initial factory
defaults

1 Press the [MENU] key to display the setup menu.

2 Press the [¥] key to move the highlighting to “USB” and then press the
[ENTER] key.

3 Press the [¥] key once to move the highlighting to “Setup” and then press the
[ENTER] key.
® This will display the Viewer setup menu.

Press the [¥] key to move the highlighting to “Initialize Viewer Setup” and then
press the [ENTER] key.
® This displays the dialog box shown below.

| (=] Initialize Viewer Setup
Do you want to restore defaults for the Yiewer setup?
Yes

Mo

[&l/[%]:Select [ENTERI/[ESC] : Return

5 Use the [A] key to select “Yes”.
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To restore all the settings to their initial defaults, press the [ENTER] key.
® To exit the operation without doing anything, press [ESC] instead of [ENTER].

7 To exit the Viewer setup menu, press the [ESC] key.

Viewer Setup Menu Contents
This section provides detailed explanations of all of the items included on the Viewer setup

menu.

Setting Name

Description

Image Zoom

In the case of image sizes other than XGA, specifies whether or not to
enlarge or reduce (zoom) images to fit the projection area.
Zoom:
Turns on image zooming.
No Zoom:
Turns off image zooming.

Display Sequence
Setup

Specifies the sequence of images in the file menu or presentation menu.
File Names (Ascending):
Displays files in file name ascending order.
File Names (Descending):
Displays files in file name descending order.
Time (New-to-Old):
Displays files by the time they were last modified, from the newest to the
oldest.
Time (Old-to-New):
Displays files by the time they were last modified, from the oldest to the
newest.

Startup Mode

Specifies whether the initial view when Viewer is started up is the thumbnail
view or tree view. See “File Menu Operations” (page 31) for more information.
Thumbnails:

Specifies thumbnail view.
Tree:

Specifies tree view.

Image Switching

Specifies the slideshow image change method.
Manual:

Specifies manual image change.
Auto:

Specifies auto image change.

Slideshow Display
Interval

Specifies how long each image will remain displayed during a slideshow.
5 seconds, 10 seconds, 30 seconds, 1 minute, 5 minutes

Slideshow
Transition Effect

Specifies the image transition effect to be used during a slideshow. For more
information see “Image Transition Effects” (page 25).

Off, Slide In - Left to Right, Slide In - Right to Left, Slide In - Top to
Bottom, Slide In - Bottom to Top, Wipe - Left to Right, Wipe - Right to
Left, Wipe - Top to Bottom, Wipe - Bottom to Top, Dissolve




Setting Name

Description

Slideshow Repeat

Specifies whether or not slideshows and movie file playback should repeat
when the end it reached.
On:
Slideshows and movie playback are repeated.
Off:
Slideshows and movie playback are not repeated.

Movie Display

Specifies the display size during movie playback.
Zoom:

Enlarges to the size of the projection area.
No Zoom:

Specifies the original size of the movie file.

Initialize Viewer
Setup

Returns all Viewer setting menu items to their initial default settings. For
details, see “To restore all settings on the Viewer setup menu to their initial
factory defaults” on page 43.




Viewer Error Messages

Message

Cause

Required Action

There is a problem
with the slideshow
setup file. Cannot

start the slideshow.

There is some problem
with the presentation file

created with EZ-Converter.

Use EZ-Converter to regenerate the entire
set of presentation data (presentation file
and image files) and save the new data to
the USB memory device.

Folder does not
contain any image
files.

There is no displayable
folder, image file, or
movie file in the folder
you are trying to access
with Viewer.

® Use EZ-Converter to generate
presentation data and save it to the USB
memory device.

® Copy image files or movie files from your
computer to the folder on the USB
memory device.

Cannot display an
image file.

The image file cannot be
displayed because it is
too large to display within
the projection area or
because there is
something wrong with it.

Make sure the image files on the USB
memory device are no larger than 6 Mbytes.

%@ Important!

Progressive JPEG image files are not
supported.

Could not find an
image file.

One or more image files
that were saved as
presentation data cannot
be found.

Use EZ-Converter to regenerate the entire
set of presentation data (presentation file
and image files) and save the new data to
the USB memory device.

This movie file
cannot be played
back.

The file you are trying to
play back is an
unsupported format or
there is something wrong
with it.

® Convert the unsupported file to a file
format that is supported and copy it to
the USB memory device.

® Copy a movie file that is a format
supported by Viewer to the USB memory
device.




Viewer Troubleshooting

Some folders and/or files are not displayed in the file menu

* All the folders and/or files contained in a folder will not be displayed if there are more
than 999 folders and/or files inside the folder. If this happens, reduce the number of
folders and/or files in the folder.

* Viewer supports up to 10 folder nesting levels on a USB memory device. Anything past
the 10th nested folder is not displayed by Viewer.

How can | get images to appear more quickly?

When you select a BMP image or a large image file recorded with a digital camera on
the Viewer's image menu, it takes considerable time before the image appears. To ensure
that images appear quickly during your presentation, use EZ-Converter to convert the
images to presentation data. This will cause images to be converted to JPEG images,
which appear on the display more quickly.

| am having a hard time getting the results | want when playing a
slideshow.

* Use EZ-Converter to convert the images you want to use in the slideshow to
presentation data.

* In order to start a slideshow by highlighting an image file in a folder that is not a
presentation data folder, you first need to use the Viewer Setup menu to configure
slideshow settings (Slideshow Display Interval, Slideshow Transition Effect, Image
Switching, Slideshow Repeat).



(Projecting Comter Scree onent ver a Wireless LAN)

This section explains how to establish a wireless LAN connection between the Data Projector
and a computer and project the computer’s screen contents over the wireless LAN.

Supported Wireless LAN Devices

CASIO YW-2S wireless adapters are required in order to establish a wireless LAN connection
between a computer and the Data Projector. The YW-2S package includes two YW-2 USB
type wireless adapters, one for the Data Projector and one for the computer.

%@ Important!

® Note that use of any other wireless adapter besides the YW-2 is not supported.

® Use of the stickers that come with the YW-2 Wireless LAN adapter is not necessary
when you connect a YW-2 to the XJ-S35 Data Projector.

Computer Requirements

In addition to the “Minimum System Requirements” (page 11), the computer must also
conform to any one of the following in order to establish a wireless LAN connection with
the Data Projector.

a. YW-2 wireless adapter plugged into a USB port

b. Built-in wireless LAN function conforming to IEEE 802.11b standard

c. Add-on wireless LAN function (other than YW-2) conforming to IEEE 802.11b standard
All of the explanations in this manual are based on a computer that conforms to “a. YW-2
wireless adapter plugged into a USB port”.

Important!

There is no guarantee that all computers conforming to one of the above conditions will
be able to establish a wireless LAN connection with the Data Projector.
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Preparing the Computer for Wireless LAN Connection
with the Data Projector

Before attempting the operations in this section, be sure to prepare the computer by
following the steps below.

If you are using the YW-2 wireless adapter

On your computer, install “Wireless Connection” from the CD-ROM that comes
bundled with the Data Projector.
® For more information, see “Installing Data Projector Software” (page 11).

2 Connect the YW-2 wireless adapter to your computer’s USB port.

If you are using another wireless LAN adapter (including a computer’s built-
in wireless LAN)

1 Make sure that the wireless LAN of the computer (either a built-in wireless LAN
or add-on wireless LAN) conforms to the IEEE 802.11b standard.

2 On your computer, install “Wireless Connection” from the CD-ROM that comes
bundled with the Data Projector.
® For more information, see “Installing Data Projector Software” (page 11).



About the Data Projector’s Wireless LAN

Wireless Function and Wireless Connection Software

The Data Projector has a built-in function named “Wireless”, which you can use to
configure Data Projector settings for wireless LAN connection with a computer, and perform
Data Projector operations (such as displaying connection information, switching computers
when there are multiple computers connected over a wireless LAN, etc.) after a connection
is established. Wireless starts up automatically whenever you connect a CASIO YW-2
wireless adapter to the Data Projector's USB port.

Wireless Connection is software that runs on a Windows computer. It lets you configure
computer settings for wireless LAN connection with the Data Projector, and perform
computer operations (such as sending computer screen contents to the Data Projector)
after a connection is established. You can also use Wireless Connection to display the
“Web Setup” page for configuring advanced wireless LAN connection settings (see
“Advanced Wireless LAN Connection Settings” on page 65).

About Data Projection Connection Profiles

A setup for a wireless LAN connection is called a “connection profile”. There are two types
of connection profiles: “simple connections” and “manual connections”. The Data Projector
comes with a following connection profiles built in. You can use the Data Projector’s
Wireless function to switch the current connection profile. Since Wireless Connection is
already equipped with the same Simple Connection 1, 2, and 3 profiles as the Wireless
function, all you need do is select the same profiles with Wireless and Wireless connection
to establish a wireless LAN connection. Note, however, that this is true only when a
CASIO YW-2 wireless adapter is connected to the computer.

Connection Initial Profile Descrintion
Profile Name P
Simple

Connection 1 These profiles mainly are for establishing a simple connection

Simple _ between the Data Projector and a single computer with a

Connection 2 CASIO YW-2 wireless adapter. The settings of these profiles

Simple _ are fixed and cannot be changed.

Connection 3

E/Ianual tion 1 Sample 1 These profiles mainly are for wireless LAN connection of
onnection multiple computers to the Data Projector at the same time.

Manual The initial default setup of each profile can be used to

Sample 2

Connection 2 configure a wireless LAN connection, or you can modify the
settings of a profile to improve security and save the profile

Sample 3 under a new name.

Manual
Connection 3




Establishing a Wireless LAN Connection between the
Data Projector and a Computer

The method you should use to establish a connection between the Data Projector and a
computer depends on the type of connection you want to establish. One important
consideration is whether you want to use a Simple Connection or a Manual Connection
profile.

B One Data Projector and One Computer

In this case, connect using Simple Connection. Make sure that the same Simple
Connection profile (Simple Connection 1 or Simple Connection 2, Simple Connection 3) is
selected on both the Data Projector and on the computer.

If there are multiple 1-to-1 wireless LAN connections in the same area, use a different
connection profile (Simple Connection 1, Simple Connection 2, Simple Connection 3) for
each one.

For more information, see “Establishing a Wireless LAN Connection with a Single Computer
Using a Simple Connection” (page 53).

B One Data Projector and Multiple (Up to 4) Computers

Configure this connection using the Manual Connection Ad Hoc Mode. Make sure that all
of the profile contents (except for the IP address) of the Data Projector and the computer
are identical.

For more information, see “Establishing a Wireless LAN Connection with Multiple Computers
Using a Manual Connection” (page 55).

B Connection over a Wireless Network

Configure this connection using the Manual Connection Access Point Mode (page 81). Note
that technical knowledge about network connections is required to configure a connection
over a wireless network.

For information about configuring settings, see “To create a new computer connection
profile” (page 75). Supplementary information is also available on the CASIO website
(http://world.casio.com/projector/support/en/).

B Connection Using a Notebook Computers Built-in Wireless LAN

Use Manual Connection for this type of connection. Note that technical knowledge about
network connections is required to configure a connection over a wireless network.
Supplementary information is available on the CASIO website
(http://world.casio.com/projector/support/en/).



Wireless LAN Connection Basics

This section explains the basic procedures for configuring settings for a wireless LAN

connection between the Data Projector and a computer.

® This section includes the basics for establishing a wireless LAN connection between the
Data Projector and a single computer, or between the Data Projector and multiple
computers. For details about increasing security and settings required for connection to a
wireless LAN access point, see “Advanced Wireless LAN Connection Settings” (page 65).

® For details about projection operations after establishing a connection, see “Using Wireless
LAN for Projection” (page 91).

%@ Important!

® The procedure below assumes that the Data Projector’s plug-and-play feature is turned
on (which is the initial default setting). If you have turned off plug-and-play, turn it
back on before performing the procedure below. For more details about the plug-and-
play setting, see “Setup Menu Contents” in the User's Guide.

® The operations described here assume that the CASIO YW-2 wireless LAN adapter is
connected to the computer. In the case of a computer equipped with another
manufacturer's wireless LAN adapter or a built-in wireless LAN adapter, configure
settings in accordance with the user documentation that comes with the adapter you

are using.



Establishing a Wireless LAN Connection with a Single
Computer Using a Simple Connection

To establish a wireless LAN connection between a single computer and the
Data Projector

% Note

The following explains the simplest type of connection. It shows how to use the Data
Projector’s built-in connection profile named “Simple Connection 1” to establish a
wireless LAN connection with a single computer.

Turn on the Data Projector.
® Wait until the Data Projector's POWER/STANDBY indicator is lit green.

Connect the CASIO YW-2 wireless adapter to the Data Projector’s USB port.

® You could also turn on the Data Projector with the wireless adapter already connected to
the USB port.

® The Data Projector will detect the wireless adapter and start up its Wireless function
automatically. The message shown below will appear in the projection area.

Standing by for
Projector Name PROJECTOR
Connection Profile Simple Connection 1

h - Check to make sure that “Simple Connection 1”

Signal Strength is shown.
[ : Switch Connection Profile
AT

3 Turn on your computer and start up Windows.

If your computer is already connected to a network, disable the connection.

® On the Windows Control Panel, click “Network Connections” (“Network and Dial-up
Connection” in the case of Windows 2000). If “Local Area Connection”, “Wireless Network
Connection” or “Network Bridge” is displayed on the window that appears, right-click the
icon and then click “Disable” on the dialog box that appears.



Connect the YW-2 wireless adapter to your computer’s USB port.

® The first time you connect a wireless adapter, the message shown below may appear on
your computer screen. If it does, click the [Continue Anyway] button.

Hardware Installation

1} The software you are instaling for this hasdvase:
CASIO B02.11bvig Wieless LAN USE Adapter(38874]

bz not passad Windows Loge testing 1o vesily it compaliblity
with Windows WP, (Lell me why the testing iz sporant |

Continuing your installation of this software may impair
o destabilize the conmect operation of your syslem
either immediately or in the future. Miciozoft striongly
recommends that you stop this installation now and
contact the hardware vendor for sollware that has
pazzed Windows Logo testing.

[ Continue Arpway | [STOP Instatston |

6 Start up Wireless Connection by double-clicking the 5 icon on your computer
desktop, or select the following from the windows Start menu: [All Programs] -
[CASIO] - [Wireless Connection].

® This will cause the dialog box shown below to appear.

Searching for a projector...

Make sure the projector is tumed on
and check its connection profile.
Connection Profile: Simple Connection 1

Cancel

® When the computer finds the Data Projector, communication will start between them.

® This will establish a wireless LAN connection between the computer and Data Projector
automatically and cause the Wireless Connection window shown below to appear on the
computer screen.

£ Wireless Connection
Connection Tools Help

_‘LFJ é‘ L

Connected To >) I I N
| Projector Name PROJECTOR ]

® The contents of the computer screen will be projected automatically at this time.

® For details about Wireless Connection window operations and Data Projector remote
controller operations you can perform after establishing a connection, see “Using Wireless
LAN for Projection” (page 91).
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% Note

A message like “Wireless Connection.exe is trying to access the Internet” may appear
when the computer you are using has security software installed. If this happens, select
“Always allow (access)” on the dialog box.

To terminate Wireless Connection operation, click the [x] button in the upper
right corner of the Wireless Connection window or select [Exit] on the
[Connection] menu.
® This will close the Wireless Connection window and terminate the connection between the
computer and Data Projector. At this time, the projected image will return to the
message in step 2 of this procedure.

%@ Important!

The above procedure will not establish a wireless LAN connection if the connection
profile of the Data Projector is different from the profile used the first time a connection
was established between the computer and Data Projector (Simple Connection 1 in this
example). In this case, press the Data Projector's remote controller [[J] key to display
the “Connection Profile” menu and then select the original connection profile (Simple
Connection 1 for this example). For details, see “To switch the Data Projector
connection profile” (page 69).

Establishing a Wireless LAN Connection with Multiple
Computers Using a Manual Connection

This section explains how to connect up to four computers to a single Data Projector (over
a wireless LAN access point) at the same time. The following are the general steps that
are required.

@ Prepare for wireless LAN connection of the Data Projector and the computers (below).

@ Create connection profiles for the computers (page 56).

® Use the Manual Connection profile to establish a wireless LAN connection between the
first computer and the Data Projector (page 58).

@ Use the Manual Connection profile to establish a wireless LAN connection between the

other computers and the Data Projector (page 63).

®To prepare for wireless LAN connection of the Data Projector and the
computers

1 Install Wireless Connection on all of the computers.

2 Connect YW-2 wireless adapters to the USB port of each of the computers.



@To create connection profiles for the computers

Start up Wireless Connection on the first computer.

® Wireless Connection should start up automatically when you connect the YW-2 wireless
adapter to the computer's USB port. If it does not, go to the Windows [Start] menu and
select [All Programs] - [CASIQO] - [Wireless Connection].

On the Wireless Connection window of the first computer, select “Switch
Connection Profile” on the “Connection” menu.
® This will display a dialog box for switching the connection profile.

Click the [New] button.
® This will display a dialog box for configuring a new manual connection profile.

Manual Connection Setup El
Frofile Name | TR
581D

& AdHoc O Access Foirt
Securily Sehup

O ~
'WEP Kay Format WPAMPAZ Encoding

WEP Key/WPAMPAZ Pass Phease

DHCP
@ 0n
O oK
IP Addiess
Subnet Mask.

Diafault Gabevesy
Charnel Auta »

(o]




Configure the settings on the dialog box.

® In this example, we will use the following settings.

Dialog Box Item Setting

Profile Name Test

SSID CASIO_DPJ
Access Mode Ad Hoc
Security Setup WEP

WEP Key Format ASCII/128bit
WEP Key/WPA/WPA2 Pass Phrase 1234567890abc
DHCP Off

IP Address 192.168.100.1

Subnet Mask

255.255.255.0

Default Gateway

0.0.0.0

Channel

Auto

® For details about each of the settings on the dialog box, see “Manual Connection Setting

Reference” (page 80).

5 After configuring all of the settings you want, click the [Register] button.

On the confirmation dialog box that appears, click the [OK] button.

® This will register your settings as a new connection profile (named “Test” here) and
return to the connection profile switching dialog box in step 1. The newly created profile

(Test) will be selected on the dialog box.

Repeat steps 1 through 5 for all of the other computers.
® For the settings in step 4, simply change the IP address as shown below.

Computer 2: 192.168.100.10
Computer 3: 192.168.100.11
Computer 4: 192.168.100.12




®@To use the Manual Connection profile to establish a wireless LAN
connection between the first computer and the Data Projector

% Note

Perform the following steps while the connection profile dialog box is on the display at
the end of the procedure under “@ To create connection profiles for the computers”
(page 56).

Use the Simple Connection profile to establish a wireless LAN connection
between the first computer and the Data Projector.

® See “Establishing a Wireless LAN Connection with a Single Computer Using a Simple
Connection” on page 53 for more information.

® |f a Simple Connection is already established between the first computer and the Data
Projector, proceed to step 2.

On the Wireless Connection window of the first computer, select “Switch
Connection Profile” on the “Connection” menu.

® This will display a dialog box for switching the connection profile.

Click the “Profile Name” down arrow button and then select “Test” from the
menu that appears.

4 Click the [Send Settings] button.
® This will display a dialog box for sending the setup.

Send Settings @

Send Destination

® Hisnual Conneton T

() Manual Connection 2
O Manual Connection 3

[ 0K I [ Cancel l [Sendelions]

Select “Manual Connection 1” for “Send Destination”, and then click the [OK]
button.

® This will display a dialog box prompting you to enter the current password.

Input Web Password

A'\w'eh pazsword iz required.
Input the ‘Web password and chok [0K].

® Enter the password that you use when logging in to Web Setup (page 65). The initial
default password is “casio”.

6 Enter the password and then click the [OK] button.



Keep clicking the [OK] button on the dialog boxes that appear.

® Clicking the [OK] button in response to the “Overwrite it?” message will cause the
settings of the first computer to be sent to the Data Projector. At this time, the Manual
Connection 1 settings of the Data Projector will be overwritten with the “Test” settings of

the connection profile of the computer (see step 3 above). The IP address setting will be
the IP address of the computer’s connection profile plus 1.

8 To return to the Send Settings dialog box, click the [Cancel] button.

9 Click the [Close] button.
® This will cause the dialog box shown below to appear.

Searching for a projector...

Make sure the projector is tumed on
and check its connection profile.
Connection Profile: Test

=)

0 On the Data Projector’s remote controller, press the [[(1] key.
® This will cause the connection profile menu to appear in the projection area.

[ ComectionProfie
@ Sinple C: 1
© Sinple Connection 2
© Sinple Connection 3
© Manual Connection 1 Manual Connect
© Manual Connection & sample;
© Manual Connection 3 samp &

TAT/L¥] : Select [ENTER] : Switch [ESC): Return

11 Use the [¥] key to move the highlighting to “Manual Connection 1” and then
press the [ENTER] key.

® This will display the dialog box shown below.

E LConnection Profile
Switch the connection profile?
Yes

[
[A]/1¥]: Select iﬁi&]{[ﬁ: : Return

12 Press the [A] key to move the highlighting to “Yes” and then press the [ENTER]
key.

® This will cause the message shown below to appear in the projection area.

Standing by for
Projector Name PROJECTOR
Connection Profile Manual Connection 1 (Test)
510 CASIO_DPJ "\:\
IP Adde 142.168.100. 2
i N - Check to make sure that “Manual Connection 1
Sigral Strength | (Test)” is shown.
e =L ST e e LSa————
[ : Switch Connection Profile
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1 Check the message that appears on the computer screen.

® When the computer finds the Data Projector, the display will change to a dialog box like
the one shown below for selecting the connected device.

Connection g|
l Refrezh Screen ] l Fiegister Projector I
Projector Mame IP Address
PROJECTOR 192.168.100.2

If there are other XJ-S35 Data Projectors with
wireless adapters connected in the area, all
of them that are detected will appear in the
list.

Move the highlighting to the XJ-S35 Data Projector to which you want to
connect and then click the [OK] button.
® The computer will connect with the Data Projector and the above dialog box will close.
Confirm that the “Connection Profile” setting for the connected device information on the

Wireless Connection window shows “Manual Connection 1 (Test)”.

£ Wireless Connection

Connection  Tools Help

User Mame:

IP Address:

Connected To

192.168.100.1

bl & ¥z ] L]

{10
o)

O
(@) |

bofbe
Jbofbef

PN T T T 1

Projector Mame

Connection Keyword
SSID

Access Mode
DHCP

IP Address

Subnet Mask
Default Gateway
Security Setup

PROJECTOR

off
CASIO_DRJ
&dHoc

Qff
152.168.100.2
255,255 2550
0000

WEP
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On the Wireless Connection window, select “Options” on the “Tools” menu.
® This will display a dialog box for configuring the option setting.

User Mame

Quabty
() High-quality

() Nornal-quality

‘wieb Setup

Click the button belows bo start up your Web
beowises,

which will display a page

wou can use bo view and modily settings.

6 In the “User Name” box, enter the user name (the name you want to appear in
the projection area when projecting the screen contents of this computer) for the
computer whose settings you are configuring.

® You can input up to 10 characters for the user name.

17 Click the [OK] button.



8 On the Wireless Connection window, click one of the projection area position

® This will cause the contents of the computer screen to be projected so they fill the
entire projection area. At this time the user name will appear in the upper left corner of
the projection area.

| £ Hillians |

Market Share

W ARE Co,
BED Tech
 Cool
ODynamic
Wt

1 On the Data Projector’s remote controller, press the [O] key.
® This will display a user menu like the one shown below. You can use the user menu
when multiple computers are connected to the Data Projector to select which computer’s
screen image will fill the entire projection area. The location of each computers image
on the user menu screen will be in accordance with the projection area position button
you selected for the computer.

Market Share

= User Names
." “Not connected” appears in
= 2 place of the user name for all

positions that do not have a
computer assigned using the
projection area position buttons.

[aldwlalw]:sekct [Eater] : Svitch
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@To use the Manual Connection profile to establish a wireless LAN
connection between the other computers and the Data Projector

% Note

Perform the following steps after finishing the procedures under “@ To create connection
profiles for the computers” (page 56) and “®@ To use the Manual Connection profile to
establish a wireless LAN connection between the first computer and the Data Projector”
(page 58).

1 On the connection profile switching dialog box for each of the other computers,
click the “Profile Name” down arrow button and then select “Test” from the
menu that appears.

Click the [Close] button.
® This will cause the dialog box shown below to appear.

Searching for a projector.
Make sure the projector i turned on and
check itz connection profile.

Connection Profile : Manual Connaction Test

Cancel

® When the computer finds the Data Projector, the display will change to a dialog box like
the one shown below for selecting the connected device.

[ Refrezh Screen ] l Fiegister Projector i

i Projector Mame IP Address
PROJECTOR 192.168.100.2

| Cancel |

Move the highlighting to the XJ-S35 Data Projector to which you want to

connect and then click the [OK] button.

® The computer will connect with the Data Projector and the above dialog box will close.
Confirm that the “Connection Profile” setting for the connected device information on the
Wireless Connection window shows “Manual Connection 1 (Test)”.



On the Wireless Connection window, select “Options” on the “Tools” menu.
® This will display a dialog box for configuring the option setting.

In the “User Name” box, enter the user name (the name you want to appear in
the projection area when projecting the screen contents of this computer) for the
computer whose settings you are configuring

® You can input up to 10 characters for the user name.

Click the [OK] button.

On the Wireless Connection window, click one of the projection area position

buttons and then click the 57| button.

® A projection area that is available for selection is indicated by 8 while an area that is
already selected is indicated by ' . You can select any one of the areas that has 8
indicated.

® The screen contents of the second computer will appear in the area of the projection
area position button you select here.

Repeat steps 1 through 7 for the third and fourth computers.

® The screen contents of the third and fourth computer will appear in the area of the
projection area position buttons you select here.

Market Growth Market Share

[ oo

rp A repB el rel

[aldwlfalw]:sekct [Enter] : Svitch

To use the entire projection area to display a particular computer’s screen

image, use the cursor keys to move the highlighting to the desired image and

then press the [ENTER] key (or [O] key).

® This will cause the contents of the highlighted computer screen to fill the entire projection
area.

® For details about Wireless Connection window operations and Data Projector remote
controller operations you can perform after establishing a connection, see “Using Wireless
LAN for Projection” (page 91).



Advanced Wireless LAN Connection Settings

This section explains how to configure advanced settings for a wireless LAN connection

between the Data Projector and a computer.

® All of the operations in this section assume that you have already configured the settings
under “Wireless LAN Connection Basics” (page 52).

® For details about projection operations after establishing a connection, see “Using Wireless
LAN for Projection” (page 91).

Web Setup

In order to modify the settings of a Data Projector manual setup profile and to configure
advanced settings of other Data Projector settings, you need first to display a special web
browser page named “Web Setup” on you computer screen. To display Web Setup, use a
web browser running on a computer that is connected to the Data Projector over a
wireless LAN.

To display and log into the Web Setup page

1 Use the Simple Connection profile to establish a wireless LAN connection
between a computer and the Data Projector.
® See “Establishing a Wireless LAN Connection with a Single Computer Using a Simple
Connection” on page 53 for more information.
® |f a Simple Connection is already established between the first computer and the Data
Projector, proceed to step 2.

2 On the Wireless Connection window of the computer, click the button.
® This will start up the computer’s default browser and display an initial page like the one
shown below.
® The Web Setup page may not appear if your browser is running already. In this case,
quit the browser and then click the button again.

oo




3 Enter the password and then click the [OK] button.
® The initial default password is “casio”.
® The above step will display the Web Setup top page like the one shown below.

Erejectee Haere: Frogeeni A
Consection Eeyword OFF

=8

% Note

® For security reasons, be sure to change the password to something else as soon as
possible. For details, see “To change the Web Setup login password” (page 66).

® You also can display the Web Setup page by selecting “Options” on the Wireless
Connection window’s “Tools” window. On the option dialog box that appears, click the
[Web Setup] button.

To log out of Web setup
Click “Logout” in the upper right corner of the page.

% Note

You also will be logged out automatically if you do not perform any Web Setup page
operation for about five minutes.

To change the Web Setup login password

On the initial Web Setup page, click the [Change Password] button.
® This will display the change password page.

2 In the “Current Password” box, enter the current password (“casio” if you have
not yet changed the initial default password) and then enter the new password
into the “New Password” box.
® A password must have at least four single-byte characters and it can be up to 16

characters long.

3 Input the new password again into the lower “New Password” box.



4

Click the [Change] button.

® If you input all of the required information correctly, your password will be changed and
the Web Setup top page will reappear.

Enabling and Disabling Web Setup

This section explains how you can disable the Web Setup page so it is not displayed
when you perform Data Projector operations. You can disable the Web Setup page when
you want to restrict access to Web Setup while there are multiple computers connected to
the Data Projector.

To enable and disable Web Setup

1

2

While Wireless is shown in the projection area, press the [MENU] key on the
Data Projector’s remote controller.
® This will display the setup menu.

Press the [¥] key to move the highlighting to “USB” and then press the
[ENTER] key.

Press the [¥] key once to move the highlighting to “Setup” and then press the
[ENTER] key.
® This will display the Wireless setup menu.

mireless Setup

Conrection Keyword COn @OFf

Show User Name Display @0n OOff

Web Setup @ Enable O Disable

Initialize Wireless Setup QK [ENTER]

[a]/[¥]:Select [4]/[p]:Modify [ESC] @ Quit

Press the [¥] key to move the highlighting to “Web Setup”.

Use [P] and [4] to select “Enable” or “Disable”.

® Selecting “Disable” will make it impossible to access the Web Setup page from any
computer.

To exit the Wireless setup menu, press the [ESC] key.



Switching the Data Projector Connection Profile

The Data Projector uses one of its six connection profiles to connect to a computer over
a wireless LAN. You can use the following procedure to switch the connection profile as
required.

To view the Data Projector’s current connection profile information

While Wireless is shown in the projection area, press the [FUNC] key on the
Data Projector’s remote controller.
® This will display the Wireless function menu.

E Hireless Functions
View Irfe () |
[ : Switch Connection Profile Manual Connection 1

AJ/[W]:Select 0K [ESC] & Quit

® The contents of the Wireless function menu will differ according to the operational status
of the Data Projector when you press the [FUNC] key. The above example shows the
menu when the [FUNC] key is pressed while “Standing by for connection..” is displayed
in the projection area.

2 Check to make sure that “View Connection Info” is selected and then press the
[ENTER] key.
® This will display the connection information window, which shows the currently selected
profile and the settings of the profile.

E Connection Info
Projector Name PROJECTOR
Connection Profile Simple Connection 1
(Simple Connection Profile)
Signal Strength Lot
[ESC] : Return
=
E Connection [nfo
Projector Name PROJECTOR
Connection Profile Manual Connection 1
Frofile Name Manual Connect
5500 CASIO_DPJ
Access Mode Ad Hoc
DHCGP Off
1P Address 192162, 30. 1 (Manual Connection Profile)
Subnet Mask 266,255,265, 0
Default Gateway 0o
Security Setup WEP
Channel 10
Connection Keyword Off
Signal Strength [ o -
[ESC] : Return
e

To close the connection information window, press the [ESC] key of the Data
Projector’s remote controller.

% Note

You can also view the Data Projector’s current connection profile information using the
Web Setup top page. For more information, see “To display and log into the Web Setup
page” (page 65).
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To switch the Data Projector connection profile

On the Data Projector’s remote controller, press the [[1] key.
® This will cause the connection profile menu to appear in the projection area.

: @ Sinple Connection 1

© Sinple & ion 2
© Sinple Connection 3 The currently selected connection
© Manual Connection Manual Connect, profiled is highlighted.
© Manual Connection sampled

& Manual Connec MeetingRooal

tion
[&]/1¥] : Select m:m : Return

2 Use the [¥] and [A] keys to move the highlighting to the connection profile you
want to select and then press the [ENTER] key.
® This displays the dialog box shown below.

‘Switch the connection profile?

Yes

[
.Ilﬁ"l:&hot IE‘;W&} = Return
e e e ————————

ess the [A] key to move the highlighting to “Yes” and then press the [ENTER]

3 Pr
key.
® This will switch to the Data Projector connection profile you highlighted in step 2 and

then display the “Standing by for connection..” message.

ProjemurNane
Connection Profile Sinple Connection 3

This is the display of the connection
profile name after switching.
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To use Web Setup to modify the Data Projector connection profile from a
computer

%@ Important!

Performing the procedure below will terminate the current wireless LAN connection
between the Data Projector and computer. To re-establish a connection, reconfigure the
computer’s wireless LAN settings so they match those of the new Data Projector
connection profile.

1 Perform the procedure under “To display and log into the Web Setup page”
(page 65) to display the Web Setup top page.

2 Click the “Connection Profile” down arrow button and then select the connection
profile you want from the menu that appears.

3 Click the [Switch] button.
® This will display the following message on the Web Setup page.

The connection profile has been changed.
Switch the settings on the computer and then re-connect.

4 Click the [OK] button.
® This will switch the Data Projector to the connection profile you selected in step 2 and
terminate the current wireless LAN connection between Data Projector and computer.
® At this time, the message “Standing by for connection..” will appear in the projection
area, along with the connection profile you switched with “Connection Profile” in step 2
above.



Assigning a Name to a Data Projector

You can use Web Setup to assign a unique name to each Data Projector, which comes in
handy when you are using multiple projectors. The projector name you assign is displayed
in the following locations.

* In the “Projector Name” box of the Wireless “Standing by for connection..” message

* In the “Projector Name” box of the Wireless Connection data window (page 68)

* In the “Projector Name” box of the Wireless Connection window (page 54)

* In the “Projector Name” box of the Connection dialog box (page 60)

To assign a name to a Data Projector

Perform the procedure under “To display and log into the Web Setup page”
(page 65) to display the Web Setup top page.

In the “Projector Setup” area, click the [Edit] button.
® This will display a projector setup page.
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3 Enter up to 12 characters for the name into the “Projector Name” box.

4 Click the [Save] button.

% Note

You also can use the projector setup page to define a connection keyword (see next
page).



Configuring a Connection Keyword

A connection keyword protects the Data Projector against unauthorized access when there
are multiple computers connected over a wireless LAN using a manual connection profile.
You can specify whether or not input of the connection keyword is required (connection
keyword on/off) to establish a wireless LAN connection with the Data Projector from a
computer, and you can register and modify the connection keyword as required.

You can turn the connection keyword on or off using either Web Setup or the Wireless
setup menu. Connection keyword registration and modification can be performed using Web
Setup.

To modify an existing connection keyword

Perform the procedure under “To display and log into the Web Setup page”
(page 65) to display the Web Setup top page.

In the “Projector Setup” area, click the [Edit] button.
® This will display a projector setup page.

N

Enter up to 16 single-byte characters or symbols into the “Connection Keyword”
box.

W

Select “On” when you want to require input for connection from a computer to
the Data Projector over a wireless LAN, or “Off” to turn off the connection
keyword.

=

5 After the settings are the way you want, click the [Save] button.

To turn connection keyword input on or off on the Data Projector

1 While Wireless is shown in the projection area, press the [MENU] key on the
Data Projector’s remote controller.
® This will display the setup menu.

2 Press the [¥] key to move the highlighting to “USB” and then press the
[ENTER] key.

3 Press the [¥] key once to move the highlighting to “Setup” and then press the
[ENTER] key.
® This will display the Wireless setup menu with “Connection Keyword” highlighted.

[~ Wircless Setup
Conrection Keyword Cin @OFf
Show User Name Display @0n QOff
Web Setup @ Erable C Disable
Initialize Wireless Setup QK [ENTER]
[a]/[¥]:Select [«41/[»]:Modify [ESC]:Quit




Use [P] and [4] to select “On” or “Off”.
® Selecting “On” will require connection keyword input whenever a computer tries to
connect to the Data Projector.

5 To exit the Wireless setup menu, press the [ESC] key.

To connect to the Data Projector from a computer over a wireless LAN
when connection keyword input is required

1 On the computer, perform the required operation to connect to the Data
Projector.

® To do this, perform the procedures under “Establishing a Wireless LAN Connection with
Multiple Computers Using a Manual Connection” (page 55).

On the Wireless Connection window, click the j button.
® This will display a dialog box for inputting a connection keyword.

Enter the connection keyword that is preset for the Data Projector and then click

the [OK] button.

® [f the input connection keyword is correct, a wireless LAN connection will be established
between the Data Projector and computer and the computer screen contents will be sent
to the Data Projector.

® The connection keyword you input will be cleared if it does not match the one that is
assigned to the Data Projector. Re-enter the correct keyword.

® |f you input the wrong keyword three times in a row, the connection keyword input dialog
box will not appear again when you click the [OK] button on the error dialog box. To
display the connection keyword input dialog box again, click the j button.



Modifying Data Projector Manual Connection Settings

The following are example cases in which you may want to modify Data Projector manual

connection settings.

* When you want to configure Data Projector settings to be compatible with information
configured on the wireless LAN access point you are using

* When you want to enhance security by modifying initial default settings

* When you want to establish a wireless LAN connection using a fixed IP address

¢ When using another manufacturer's wireless LAN adapter or a wireless LAN adapter built
into the computer

You can modify manual connection settings using Web Setup.

To modify Data Projector manual connection settings

%@ Important!

Performing the procedure below to modify the connection profile being used for the
wireless LAN connection between the Data Projector and computer will terminate the
current connection. To re-establish a connection, reconfigure the computer’s wireless LAN
settings so they match those of the new Data Projector connection profile.

Perform the procedure under “To display and log into the Web Setup page”
(page 65) to display the Web Setup top page.

In the “Connection Profile Setup” area, click the [Edit] button.
® This will display a dialog box for configuring the connection profile.

Click a tab (Manual Connection 1, 2, or 3) to display the connection profile
whose settings you want to modify.
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Configure the settings on the tab that is displayed.
® For details about each of the settings on the dialog box, see “Manual Connection Setting
Reference” (page 80).

To save your settings, click the [Save] button.
® This should cause the message “Your settings have been saved.” to appear.

® [f there is anything wrong with the settings, the message “Some input items are missing.”
will appear. If this happens, click [Return] in the lower left corner of the page to return
to the connection profile setup page, and correct the settings as required. When checking
your settings, refer to “Manual Connection Setting Reference” (page 80).

% Note

To use a modified connection profile for a wireless LAN connection, you will need to
switch to the profile (unless you modified the connection profile that you are currently
using). For details, see “To switch the Data Projector connection profile” (page 69).



Creating a Computer Connection Profile

After you modify the settings of the Data Projector's manual setting profile, you will also
need to modify the existing wireless LAN connection settings (connection profile) of the
computer accordingly, or you will have to create a new connection profile. This section
explains the procedure for using Wireless Connection to create a new profile or to modify
the existing profile of a computer that has a CASIO YW-2 wireless adapter connected.

%@ Important!

For the required computer wireless LAN connection settings when you are using another
manufacturer's wireless LAN adapter or the computer’s built-in LAN adapter, see the
user documentation that comes with the wireless LAN adapter or the computer you are

using.

To create a new computer connection profile

% Note

This procedure shows how to create a new computer connection profile to match
modifications made in the settings of the Data Projector’s connection profile named
“Manual Connection 3”. In this example, the projector's name (page 71) is “Projector A”.

Perform the procedure under “To modify Data Projector manual connection
settings” (page 74) to modify Data Projector’s “Manual Connection 3” profile

settings as shown below.

Dialog Box Iltem Setting

Profile Name RoomB

SSID ROOM_B
Access Mode Access Point
Security Setup WPA-PSK
WPA/WPA2 Encoding TKIP

WEP Key/WPA/WPA2 Pass Phrase 1234567890abc
DHCP Off

IP Address 192.168.10.1

Subnet Mask

255.255.255.0

Default Gateway

(To match wireless LAN access point settings.)

Channel

Auto

® The above settings are provided as an example only. When you are establishing a
wireless LAN connection using the Access Point Mode, you need to configure settings to
match the actual access point. When configuring the IP address of the Data Projector
(and the computer connecting to the Data Projector over the wireless LAN connection),
you need to make sure that the IP address of the access point is different from all other

IP addresses within the same network.

® For details about each of the settings on the dialog box, see “Manual Connection Setting

Reference” (page 80).




Perform the procedure under “To switch the Data Projector connection profile”

(page 69) to switch the Data Projector connection profile to “Manual Connection

3.

® This will cause the “Standing by for connection..” screen to appear in the projection
area. Confirm that the screen shows “Manual Connection 3” for the connection profile.

Standing by for connection..
Projector Name PROJECTOR A
Connection Profile Manual Connection 3 (RocaB)
3310 ROOM_E
IP Address 192168 10. 1
Signal Strength [ )
O Switch Connection Profile
A

On the Wireless Connection window, select “Switch Connection Profile” on the
“Connection” menu.

® This will display a dialog box for switching the connection profile.

Click the [New] button.
® This will display a dialog box for configuring a new manual connection profile.

Manual Connection Setup El
Frofile Hame | TR
581D

& AdHoc O Access Foirt
Securily Sehup

Off ~
'WEP Kay Format WPAMPAZ Encoding

WEP Key/WPAMPAZ Pass Phease

DHCP
& On

O oK
IP Addiess
Subnet Mask.

Diafault Gabevesy
Channel [Ato v

On the dialog box for configuring the manual connection setup, configure the

settings so they are the same as those that you configured for Manual

Connection 3 in step 1 of this procedure.

® Make sure that the IP address is different from the IP address you set in step 1, the IP
address of the access point, and any other IP address within the same network.

® For details about each of the settings on the dialog box, see “Manual Connection Setting
Reference” (page 80).



6 After configuring all of the settings you want, click the [Register] button.

On the confirmation dialog box that appears, click the [OK] button.

® This will register your settings as a new connection profile and return to the connection
profile switching dialog box in step 1.

Click the [Close] button.

® This closes the connection profile switching dialog box and displays the dialog box shown
below.

Searching for a projector.
Make sure the projector i turned on and
check itz connection profile.

Connection Profile : Meeting RoomB

Cancel

® When the computer finds the Data Projector, the display will change to a dialog box like
the one shown below for selecting the connected device.

[ Refrezh Screen ] l Fiegister Projector i

Projector Mame IP Address
Projector & 192168101

| Cancel |

9 Move the highlighting to “Projector A” for the projector name and then click the
[OK] button.
® This will establish a wireless LAN connection between the computer and Data Projector.

® This will close the connected device selection dialog box and display the Wireless
Connection dialog box on the computer screen.

0 On the Wireless Connection window, click one of the projection area position
buttons and then click the 57| button.
® This will cause the contents of the computer screen to be projected so they fill the
entire projection area.
® For details about Wireless Connection window operations and Data Projector remote
controller operations you can perform after establishing a connection, see “Using Wireless
LAN for Projection” (page 91).



To modify an existing computer connection profile

1 Display the Wireless Connection window by double-clicking the 5 icon on your
computer desktop, or select the following from the windows Start menu: [All
Programs] - [CASIO] - [Wireless Connection].

® This step is not necessary if the Wireless Connection window is already displayed.

2 On the Wireless Connection window, select “Switch Connection Profile” on the
“Connection” menu.
® This will display a dialog box for switching the connection profile.

3 Click the “Profile Name” down arrow button and then select the connection
profile you want to modify from the menu that appears.

Click the [Change Setup] button.
® This will display a dialog box for configuring a new manual connection profile.

On the dialog box, modify the settings as required.

® For details about each of the settings on the dialog box, see “Manual Connection Setting
Reference” (page 80).

After configuring all of the settings you want, click the [Register] button.
® This will cause the dialog box shown below to appear.

A profile named ‘Manual Connection 3 already exists,
Crwerwrite it?

7 Click the [OK] button.
® This registers the settings you modified in the manual setting in step 5 and returns to
the connection profile switching dialog box.

Deleting a Computer Connection Profile

You can use the procedure in this section to delete computer connection profiles you
created with Wireless Connection when you no longer need them. Wireless Connection can
also be used to delete the default connection profiles (Manual Connection 1, 2, and 3).

To delete a computer connection profile

1 Display the Wireless Connection window by double-clicking the . icon on your
computer desktop, or select the following from the windows Start menu: [All
Programs] - [CASIO] - [Wireless Connection].

® This step is not necessary if the Wireless Connection window is already displayed.

2 On the Wireless Connection window, select “Switch Connection Profile” on the
“Connection” menu.
® This will display a dialog box for switching the connection profile.



3 Click the “Profile Name” down arrow button and then select the connection
profile you want to delete from the menu that appears.

After the settings are the way you want, click the [Delete] button.

=

To close the connection profile switching dialog box, click the [Close] button.
® This will return to the Wireless Connection window.

Assign a User Name to a Computer for Projection

User names make it possible to identify each computer when multiple computers are
connected to the Data Projector at the same time. The user name assigned to a computer
will appear in the projection area when the computer’s screen contents are projected. Use
Wireless Connection to assign a user name to each computer.

To assign a user name to a computer for projection

On the Wireless Connection window, select “Options” on the “Tools” menu.
® This will display a dialog box for configuring the option setting.

In the “User Name” box, enter the user name for the computer.
® Input up to 10 characters.

3 Click the [OK] button.
® This will register the user name.

Specifying the Quality of Images Sent from a Computer
Use the procedure below to specify the quality of images you send from a computer. The

“High-quality” setting provides better image quality, while the “Normal-quality” setting makes
the send operation faster.

To specify image quality

On the Wireless Connection window, select “Options” on the “Tools” menu.
® This will display the [Options] dialog box.

2 Under [Quality], select the quality setting you want.

When the setting is the way you want, click [OK].
® This will apply your setting.



Manual Connection Setting Reference

This section provides detailed explanations of all of the manual connection settings.

* See “To modify Data Projector manual connection settings” (page 74) for information
about how to change Data Projector manual connection settings.

* For information about creating a computer manual connection setting profile for wireless
LAN connection with the Data Projector, refer to “To create a new computer connection
profile” (page 75). For information about modifying a manual connection setting profile,
refer to “To modify an existing computer connection profile” (page 78).
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Computer Manual Connection Setting Screen
Wireless Connection Manual Connection Setting
Dialog Box

Data Projector Manual Connection Setting
Screen
Connection Profile Setting Page
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% Note

The initial default setting for each item is indicated by an asterisk (*).

Setting Name

Description

Profile Name

This is a name assigned to identify each individual manual connection.
Input up to 10 characters.

SSID

Wireless network ID name. This is normally referred to as the SSID, ESS-ID,
or network name. Input up to 32 single-byte alphanumeric characters.

Access Mode

Specifies either wireless LAN connection through an access point or direct
connection between the Data Projector and computer without going through
an access point.
Access Point:
Specifies wireless LAN connection through an access point.
Ad Hoc*:
Specifies direct wireless LAN connection between the Data Projector and
computer.

Security
Setup

Specifies whether or not communication over the wireless LAN connection is
encrypted. A setting to select the encryption type is also provided. The Data
Projector supports three types of encryption: WEP, WPA-PSK, and WPA2-
PSK.
Off*:
Encryption turned off.
WEP:
Turns on WEP encryption. When this option is selected, you also must
specify a WEP key format and a WEP key.
® The letters “WEP” stand for “Wired Equivalent Privacy”. It is a security
protocol that uses a character string to encrypt data and protect against
unauthorized access to wireless communications.
WPA-PSK:
Turns on WPA-PSK encryption. When this option is selected, you also must
specify a WPA/WPA2 encoding and a WPA/WPA2 pass phrase.
® The letters “WPA” stand for “Wi-Fi Protected Access”. Like WEP, it is a
security protocol that encrypts communication data. WPA uses an
automatically generated encryption key that is changed at preset
intervals, which provides stronger security than WEP.
WPA2-PSK:
Turns on WPA2-PSK encryption. When this option is selected, you also
must specify a WPA/WPA2 encoding and a WPA/WPA2 pass phrase.
® WPA2 is a new standard of WPA.

% Note

You cannot select WPA-PSK or WPA2-PSK when “Ad Hoc” is selected
for the “Access Mode” setting.

WEP Key
Format

You only need to configure this setting when “WEP” is selected for “Security

Setup”.

You can specify any one of the following formats for input of the WEP key.
ASCII/64bit, ASCII/128bit, HEX/64bit, HEX/128bit*

For more information about inputting the WEP key using the format specified

here, see the “WEP Key / WPA/WPA2 Pass Phrase” item below.




Setting Name

Description

WPA/WPA2 You only need to configure this setting when “WPA-PSK” or “WPA2-PSK” is
Encoding selected for “Security Setup”.
TKIP*:
Select “TKIP” as the encryption type.
AES:
Select “AES” as the encryption type.
WEP Key/ Use this input box to enter a WEP key or WPA/WPA2 pass phrase. What
WPA/WPA2 you need to input depends on the encryption type you selected for “Security

Pass Phrase

Setup”.
® When “WEP” is selected for “Security Setup”
Enter the WEP key. The WEP key character string should be input using
one of the following formats, in accordance with the “WEP Key Format”
setting.
ASCII/64bit

Five single-byte alpha-numeric characters (Example: “MyKey”)
ASCII/128bit

13 single-byte alpha-numeric characters (Example: “MyKey12345678”)
HEX/64bit

10-digit hexadecimal value (Example: 11AA22BB33)
HEX/128bit

26-digit hexadecimal value (Example: 00112233445566778899AABBCC)
® When “WPA-PSK” or “WPA2-PSK is selected for “Security Setup”
Enter the WPA/WPA2 pass phrase (encryption key).
Enter the same encryption key that is currently set on the wireless LAN
access point to which you are planning to connect. You should enter at
least eight and up to 63 single-byte characters, or 64-digit hexadecimal
value.

DHCP

Specifies whether the IP address that is set manually on the device being
configured (Data Projector or computer) or the IP address assigned
automatically by the DHCP server should be used during wireless LAN
connection.
Oon*:
Specifies use of the IP address assigned automatically by the DHCP
server. You do not need to configure the “IP Address”, “Subnet Mask”, or
“Default Gateway” settings when this option is selected.
Off:
Specifies use of the manually set IP address. You need to configure the
“IP Address”, “Subnet Mask”, and “Default Gateway” settings when this
option is selected.

IP Address

Configuration of this setting is required when “Off” is selected for “DHCP”.
Enter the IP address that is assigned to the Data Projector/computer. The IP
address consists of four values in the range of 0 to 255, separated by
periods (such as 192.168.10.3).




Setting Name

Description

Subnet Mask

Configuration of this setting is required when “Off” is selected for “DHCP”.
Enter a subnet mask value, which specifies the range of the IP address of
the subnet to which the Data Projector/computer belongs. The subnet mask
consists of four values in the range of 0 to 255, separated by periods (such
as 255.255.255.0).

Default Configuration of this setting is required when “Off” is selected for “DHCP”.

Gateway When “Access Point” is selected for “Access Mode”, specify the same value
as the wireless LAN access point.

Channel Configuration of this setting is required when “Ad Hoc” is selected for

“Access Mode”. When there is a large number of devices performing wireless
LAN communication using frequencies in the same frequency band (2.4 GHz)
used by the Data Projector, you can improve communication performance by
assigning different channels to each wireless LAN network. Normally you
should leave this item set to “Auto” (initial default setting).
Auto*:
Automatically assigns a communication channel for wireless LAN
communication. If “Auto” is selected on the Data Projector, also select
“Auto” for the computer as well.
1,2,3,4,56,7,8,9,10, 11:
Specify a channel that should be used for wireless LAN communication.
The same channel must be set on the Data Projector and the computer
that will be communicating with each other over the wireless LAN
connection.




Returning Data Projector Wireless Settings to Their Initial
Defaults

You can return all Data Projector Wireless function settings to their initial defaults by
executing “Initialize Wireless Setup”. The following are the Wireless initial default settings
configured by this operation.

Dialog Box Item Initial Default
Connection Keyword (page 72) Off (no keyword)
Show User Name Display (page 95) On

Web Setup (page 67) Enable

To return Data Projector Wireless function settings to their initial defaults

1 While Wireless is shown in the projection area, press the [MENU] key on the
Data Projector’s remote controller.

® This will display the setup menu.

2 Press the [¥] key to move the highlighting to “USB” and then press the
[ENTER] key.

3 Press the [¥] key once to move the highlighting to “Setup” and then press the
[ENTER] key.
® This will display the Wireless setup menu.

aﬁ Wireless Setup

Connection Keyward COn @OFf

Show User Name Display ®0n QOff

Web Setup @ Enable O Disable

Initialize Wireless Setup QK [ENTER]
[a]/[¥]:Select [4]/[p]:Modify [ESC] @ Quit

4 Press the [¥] key to move the highlighting to “Initialize Wireless Setup”.



5 Press the [ENTER] key.
® This displays the dialog box shown below.

s
Initialize Hireless
Tnitialize the Wireless setup?
Yes
ho

[a1/[¥]:Select [ENTER]/[ESC] : Return
—SEe

6 Press the [A] key to move the highlighting to “Yes” and then press the [ENTER]
key.
® This initializes all Wireless settings.

Viewing Wireless Connection Help

To view Wireless Connection help, select “Help” on the Wireless Connection window “Help”
menu.

Viewing Wireless Connection Version Information

To view Wireless Connection version information, select “About Wireless Connection..” on
the Wireless Connection window “Help” menu.

85



Wireless LAN Connection Troubleshooting

Whenever you experience problems with the wireless LAN connection between the Data
Projector and the computer, check the following points first.

Check the following on the computer.

* Did you disable “Network Connection” before connecting the YW-2 wireless LAN
adapter to your computer’s USB port?
On the Windows Control Panel, click “Network Connections” (“Network and Dial-up
Connection” in the case of Windows 2000). If you see “Local Area Connection”,
“Wireless Network Connection” or “Network Bridge” on the window that appears, right-
click the icon and then click “Disable”.

* |Is a wireless LAN utility other than Wireless Connection (which comes with the
Data Projector) running?
If so, shut down the other utility.

Check the following on the Data Projector.

* |Is the same connection profile selected on the computer and on the Data
Projector?
Wireless LAN connection is not possible when different connection profiles are selected
on the computer and the Data Projector (such as “Manual Connection 1” on the
computer and “Simple Connection 1” on the Data Projector). Make sure the same
connection profile is selected on both.

Also check the following.

* Are the Data Projector and computer too far apart or are they separated by a wall
or other barrier?
Try moving the Data Projector and computer so they are closer to each other.

* Is a microwave oven or a Bluetooth device being used nearby?
Operation of a device that uses the 2.4 GHz frequency band (which is the same
frequency band as the IEEE802.11b wireless standard used by the Data Projector) in the
vicinity of the Data Projector can cause radio interference, resulting in a wireless
communication error. Avoid using the nearby microwave oven or Bluetooth device when
performing Data Projector wireless LAN communication.

If the above countermeasures do not resolve your problem, try the following depending on
the problem you are experiencing.



You cannot establish a Manual Connection between the Data Projector and
a single computer or multiple computers.

Except for the IP address setting, all of the settings configured for the Data Projector and
the computer(s) must match in order to establish a Manual Connection. Use the following
procedures to display and check the Data Projector and computer settings. If there are any
differences in the settings, change the settings on the computer(s) so they match. It is
important to remember here, however, that the IP_addresses must be different.

To check Data Projector settings

Press the [FUNC] key, confirm that “View Connection Info” is highlighted, and then press
the [ENTER] key.

To check computer settings

1 On the Wireless Connection window, select “Switch Connection Profile” on the
“Connection” menu.

2 On the connection profile switching dialog box that appears, click the “Profile
Name” down arrow button and select the connection profile whose settings you
want to view.

Click the [Change Setup] button.

® This will display a dialog box for configuring a new manual connection profile. Use the
dialog box to check the settings and make any changes that are required.

%@ Important!

When establishing wireless LAN connections between the Data Projector and multiple
computers, the Data Projector and each of the computers must have their own unique
IP addresses. For example, you could assign the IP address 192.168.1.100 to the Data
Projector, and assign the following IP addresses to the computers: 192.168.1.10, 192.
168.1.20, 192.168.1.30, etc.



When you establish a wireless LAN connection between the Data Projector
and a computer, it takes a log of time before the contents of the computer
screen is projected.

It can take some time for a wireless LAN connection to be established between the Data
Projector and computer if any other network connection besides the wireless network
connection used by the YW-2 wireless adapter is enabled on the computer. If this
happens, perform the following steps to disable the other network connections.

On the Windows Control Panel, click “Network Connections” (“Network and Dial-
up Connection” in the case of Windows 2000).

® This will display a “Network Connections” window (“Network and Dial-up Connection”
window).

2 On the window, right click any wireless network connection that is not the one
being used by the YW-2 wireless adapter, and then click “Disable” on the
shortcut menu that appears.

® The wireless network connection used by the YW-2 wireless adapter is the one with the
adapter name “CASIO 802.11b/g Wireless LAN USB Adapter (3887A)”. Disable all
wireless network connections that have any other name.

3 If you see a “Local Area Connection” on the window, right-click its icon and
then click “Disable” on the dialog box that appears.



The wireless LAN connection between the Data Projector and computer

keeps dropping.

This can be caused by the following.

¢ Data communication can slow down and the connection may tend to drop when the
Data Projector and computer are far from each other (in different rooms, on different
floors, etc.) Move the Data Projector and computer as close together as possible.

* Operation of a device that uses the 2.4 GHz frequency band (which is the same
frequency band as the IEEE802.11b wireless standard used by the Data Projector) in the
vicinity of the Data Projector can cause radio interference that results in a wireless
communication error. Avoid using the nearby microwave oven or Bluetooth device when
performing Data Projector wireless LAN communication.

After checking the above two points, select [Exit] on the [Connection] menu of the Wireless
Connection window to exit Wireless Connection, and then restart Wireless Connection.

You cannot display the Web Setup page

The Web Setup page can be displayed only while there is a wireless LAN connection
between the Data Projector and computer. Use a Simple Connection or Manual Connection
to establish a wireless connection between the Data Projector and computer, and then
display the Web Setup page. For more information, see “Web Setup” (page 65).

If the Web Setup page does not appear even through there is a wireless LAN connection

between the Data Projector and computer, check the following points.

e The Web Setup of the Data Projector may be disabled. Use the procedure under “To
enable and disable Web Setup” (page 67) to check the current setting. If it is “Disable”,
change it to “Enable”.

* The browser you are using may be configured to use a proxy server. This can make it
impossible to display the Web Setup page, and so the proxy server settings should be
canceled. See the help and other user documentation for your browser for information
about proxy server settings.



Wireless Connection Menus and Button Reference

This section provides detailed information about the Wireless Connection window menu

commands and buttons.

. Perform this menu Or click this
To do this: X
operation: button:
Use the currently selected connection profile to open a
wireless LAN connection between a computer and the [Connection] - [Connect] h

Data Projector

Terminate a wireless LAN connection between a
computer and the Data Projector

[Connection] -
[Disconnect]

&

On the computer, switch the connection profile used
for wireless connection between a computer and the
Data Projector

[Connection] - [Switch
Connection Profile]

Terminate the wireless LAN connection between a
computer and the Data Projector and quit Wireless
Connection

[Connection] - [Exit]

Select the mouse cursor shape for the projection
screen or turn mouse cursor display off

[Tools] - [Mouse Cursor
Emulation]

]

Display the Wireless Connection option setting dialog
box (for specifying a user name or to display the Web
Setup page)

[Tools] - [Options]

Display the Web Setup page

4]

Pause computer screen contents as they are being
projected

Project computer screen contents

Stop projection of computer screen contents while
maintaining the connection

|m

View Wireless Connection Help

[Help] - [Help]

View Wireless Connection version information

[Help] - [About Wireless
Connection...]




Using Wireless LAN for Projection

This section explains operations you can perform after a connection is established between

the Data Projector and computer.

For this type of connection:

Refer to this section of this manual:

Single computer connected to the Data
Projector over a wireless LAN

“Operations while a Single Computer is Connected to the
Data Projector over a Wireless LAN” (below)

Multiple computers connected to the
Data Projector at the same time over
a wireless LAN

“Operations while a Single Computer is Connected to the
Data Projector over a Wireless LAN” (below) and
“Operations while Multiple Computers are Connected to the
Data Projector over a Wireless LAN” (page 94)

Operations while a Single Computer is Connected to the
Data Projector over a Wireless LAN

To project computer screen contents

On the computer screen, click the :j button on the Wireless Connection window.

* An image of the computer screen contents will be projected automatically, immediately
after a connection using Simple Connection is established. This means you do not have
to click the :J button to project the image.

£ Wireless Connection

Connection  Tools Help

IP Address:  192.168.100.1

| Projector Name PROJECTOR

Connection Keyword  Off

SSID CASIO_DRJ
Access Mode &dHoc
DHCP Qff

IP Address 152.168.100.2
Subret Mask 255,255 2550

Default Gateway 0.000
Security Setup WEP

b & x| = | G| |

UserName:  Williams O 8 8 ®
of&l|&jo

Connected To ) | I I

* This will send the contents of the computer screen to the Data Projector, which will
project it. The color of the :J button at this time will change from black to green.




% Note

While the computer screen contents are being projected, the mouse cursor will be
displayed in accordance with the Mouse Cursor Emulation settings configure with
Wireless Connection. For details, see “To display a mouse cursor in the projection area
(page 92).

»

To pause computer screen contents as they are being projected

On the computer screen, click the lj button on the Wireless Connection window. This will
cause the E button color to change from black to green, and pause the screen contents
in the projection area.

To unpause projection of the mage, click the :j button.

To stop projection of computer screen contents while maintaining the
connection

On the computer screen, click the ﬂ button on the Wireless Connection window. This will
cause the !J button color to change from black to green the projection area to go black.
To resume projection of the image, click the :j button.

To display a mouse cursor in the projection area

1 Click the button or select [Mouse Cursor Emulation] on the [Tools] menu.
® This will display a mouse cursor emulation dialog box.

O OFF
@]

%

@)

o3 oo &

[lo&€ o dleold
_ofoDoV

0K [ Cancel ]

2 Select the type of mouse cursor you want to use and then click the [OK]
button.

® This will display the selected mouse cursor in the projection area. The mouse cursor will
be located at the same location as the mouse cursor on the computer screen.



% Note

® The mouse cursor displayed using mouse cursor emulation is not the same mouse
cursor as displayed on the computer screen. Wireless Connection detects the location
of the mouse cursor on the computer screen and displays the mouse cursor
emulation in the projection area.

® If you do not want a mouse cursor in the projection area, select “Off” in step 2
above.

To terminate the wireless LAN connection between a computer and Data
Projector from the computer

On the computer screen, click the £ button on the Wireless Connection window, or select
“Disconnect” on the “Connection” menu.
This will terminate the wireless LAN connection between the computer and Data Projector

”»

and display “Standing by for connection..” in the projection area.

To restore the wireless LAN connection between a computer and Data
Projector from the computer

On the computer screen, click the @ button on the Wireless Connection window, or select
“Connect” on the “Connection” menu.



Operations while Multiple Computers are Connected to
the Data Projector over a Wireless LAN

While multiple computers are connected to the Data Projector over a wireless LAN, you
can check which computer’s screen contents currently are being projected, and you can
switch projection between computer screens as required. Use the Data Projector's remote
controller to perform these operations.

To check which computer’s screen contents currently are being projected.

On the Data Projector's remote controller, press the [A] key. This will display the user
name of the computer whose screen contents are currently being projected.

To switch projection from the screen contents of one computer to another

1 While the screen contents of one of the computer’s connected over a wireless
LAN connection are being projected, press the [O] key on the Data Projector’s
remote controller.

® This will switch to the user menu that shows thumbnails of the screen contents of all the
connected computers along with their user names, as shown below.

Market Share

reA B reeC  reel

[aldwlfalw]:sekct [Enter] : Svitch

2 Use the cursor keys on the Data Projector’s remote controller to move the
highlighting to the thumbnail you want to select.

3 Press the [ENTER] key or the [O] key.
® This will cause the contents of the selected computer screen to be projected so they fill
the entire projection area.



To

S

a b

turn display of user names in the projection area on and off

Note
Under initial default settings, the user name is displayed in the upper left corner of the
projection area whenever you switch projection from the contents of one computer
screen to another, or when a single computer is connected to the Data Projector over
a wireless LAN.

While Wireless is shown in the projection area, press the [MENU] key on the
Data Projector’s remote controller.
® This will display the setup menu.

Press the [¥] key to move the highlighting to “USB” and then press the
[ENTER] key.

Press the [¥] key once to move the highlighting to “Setup” and then press the
[ENTER] key.
® This will display the Wireless setup menu.

aﬁ Wireless Setup

Connection Keyword Cin @OFf

Show User Name Display ®0n QOff

Web Setup @ Enable O Disable

Initialize Wireless Setup QK [ENTER]
[a]/[¥]:Select [«41/[»]:Modify [ESC]:Quit

Press the [¥] key to move the highlighting to “Show User Name Display”.

Use [P] and [4] to select “On” (user name displayed) or “Off” (user name not
displayed).

To exit the Wireless setup menu, press the [ESC] key.



Document Camera

This section explains how to connect the CASIO YC-400 Multi PJ Camera System (document
camera) to the Data Projector in order to project the images of documents placed on the
document stage of the document camera. The Data Projector’s built-in application named YC
Camera is used to project document images.

Important!

A YC-400 document camera can be connected to the Data Projector only if the camera
is running firmware version 1.1 or higher. For information about checking the firmware
version of your YC-400 document camera, visit the CASIO website at:
http://world.casio.com/projector/download/en/yc_400_firmup/

YC Camera Application Function and Operation
Overview

YC Camera is an application built into the Data Projector that makes it possible to control
the YC-400 document camera from the Data Projector. With the YC Camera application you
can project the image of documents placed on the document stage of the document camera.
Connecting the document camera to the Data Projector's USB port and turning on the
document camera will cause the YC Camera application to start up automatically.

Connecting the Document Camera to the Data Projector

This section provides the basic steps you need to perform in order to connect the
document camera to the Data Projector and project the image of documents placed onto
the document camera’s document stage.

Important!

The procedure below assumes that the Data Projector’s plug-and-play feature is turned
on (which is the initial default setting). If you have turned off plug-and-play, turn it back
on before performing the procedure below. For more details about the plug-and-play
setting, see “Setup Menu Contents” in the User's Guide.
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To connect the document camera to the Data Projector and project the
image of a document

Turn on the Data Projector.
® Wait until the Data Projector's POWER/STANDBY indicator is lit green.

Connect the document camera to the Data Projector using the USB cable that
comes bundled with the document camera.

Document stage

With nothing on the document stage, press the [(l)] (power) button on the

camera stand.

® This will turn on the document camera, which will cause its lens to extend.

® The Data Projector will recognize the document camera and start up the YC Camera
application automatically. When the YC Camera application starts up, the Data Projector
will project an image of the document stage along with a dialog box for adjusting the
document camera position.

® |f the document camera is positioned correctly, position adjustment will end automatically
and the dialog box will close. At this time the monitor screen (the image being picked
up by the document camera) will be projected.

® |f the document camera is not positioned correctly, a message prompting you to adjust
the document camera position will appear. Follow the instructions shown in the message
to adjust the document camera position.



Place the document whose image you want to project onto the document

camera’s document stage.

® Be sure to place the document in the center of the
stage, and do not let any part of the document
extend off the edges of the stage.

® When placing a landscape orientation document onto
the document stage, the top of the page should face
towards the camera stand.

® |Initially the monitor image will be projected, and so
the image will appear a bit fuzzy.

L-]

® When the document camera senses that the document on the stage is not being moved,
it will record its image and switch from the fuzzy monitor image to a high-resolution
image (recorded image) automatically.

Rough (Monitor) Image Recorded Image

Now you can replace the document currently on the stage with another one.
® This will switch to the recorded image of the next document automatically.

% Note

Step 5 above is what happens while the Data Projector's YC Camera application is
configured with its initial default settings. The recorded image will not switch
automatically if you have changed the “Operation Mode” setting of the YC Camera
application to “Manual Capture”. For more information, see “YC Camera Application
Setup Menu Contents” on page 106.




YC Camera Application Operations

This section explains the various types of projection operations you can perform with the YC
Camera application and how to configure YC Camera application settings.

Important!

The procedures in this section assume that you have already connected the YC-400
Document Camera to the Data Projector as explained under “Connecting the Document
Camera to the Data Projector” (page 96), and that the Data Projector's YC Camera
application is running.

YC Camera Application Projection Operations

The operations in this section are performed using the YC Camera function menu, which
appears when you press the [FUNC] key while the YC Camera application is running.

[£3 YC Camera Functions
Camera Shutter
Camera Zoom/Focus
Adjust Document Camera
[]:Rotate Right
[AJ:Enhance White
[C1]:Skew Correction

[a]/[¥]:Select [ENTER]:OK [ESC]:0uit

Some operations can be performed using the remote controller's [O], [A], and [J] keys.

To release the document camera shutter manually

1 Press the [FUNC] key to display the YC Camera application function menu.
® The “Camera Shutter” item should be highlighted by default.

2 Press the [ENTER] key to release the document camera shutter.
® This will cause the image recorded with the document camera to be projected.

% Note

While a rough monitor image or recorded image is projected, you can release the
shutter manually by pressing the [ENTER] key, without pressing the [FUNC] key.
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To adjust the document camera’s zoom setting

1
2

3

Press the [FUNC] key to display the YC Camera application function menu.

Use the [¥] key to move the highlighting to “Camera Zoom/Focus” and then
press the [ENTER] key.

® This causes the YC Camera Zoom/Focus dialog box to appear in the projection area.
The “Optical Zoom” item should be highlighted by default.

Optical Zoom o —
I s 5 7 |
Refocus 0K [ENTER]

[a]/[¥]:Select [«w]/[»]:Modify [ESC] : Quit

Use the [P] and [4] keys to adjust the document camera’s zoom setting.

After the zoom setting is the way you want, press the [ESC] key.
® This will close the YC Camera Zoom/Focus dialog box.

To adjust document focus manually

W

Press the [FUNC] key to display the YC Camera application function menu.

Use the [¥] key to move the highlighting to “Camera Zoom/Focus” and then
press the [ENTER] key.
® This causes the YC Camera Zoom/Focus dialog box to appear in the projection area.

Optical Zoom o —
I s 5 7 |
Refocus 0K [ENTER]

[a]/[¥]:Select [«w]/[»]:Modify [ESC] : Quit

Press the [¥] key to move the highlighting to “Focus”.
Use the [P] and [4] keys to adjust the document camera’s focus.

After the focus is the way you want, press the [ESC] key.
® This will close the YC Camera Zoom/Focus dialog box.
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To adjust the camera position

q
2
3

Remove all documents and objects from the document stage.
Press the [FUNC] key to display the YC Camera application function menu.

Use the [¥] key to move the highlighting to “Adjust Camera Position” and then
press the [ENTER] key.

® This displays the camera position adjustment dialog box.

Point the document camera downwards so the lens is pointed towards the
document stage.

® Aim the camera as instructed by the text that appears in the projection area.

Flaass

Do ot ouch the document stard
Adjusting focum e

® When the document camera is positioned correctly, position adjustment will end and the
dialog box will close. At this time the monitor screen (the image being picked up by the
document camera) will be projected.



To rotate the currently projected image

% Note

This operation will affect only the image that is currently being projected. The projection
image produced the next time you release the shutter will be projected in accordance
with the settings on the YC Camera Application Setup Menu (page 104).

1 Press the [FUNC] key to display the YC Camera application function menu.

2 Use the [¥] key to move the highlighting to “Rotate Right” and then press the
[ENTER] key.
® This will rotate the projected image 90 degrees to the right.
® Instead of steps 1 and 2 above, you can also rotate the projected image by pressing
the [O] key.

To perform white enhancement on the currently projected image

% Note

® White enhancement causes the background of the projected image to be white
enhanced, which helps to make the text on a document easier to read.

® This operation will affect only the image that is currently being projected. The
projection image produced the next time you release the shutter will be projected in
accordance with the settings on the YC Camera Application Setup Menu (page 104).

%@ Important!

You can perform white balance only on a projected image that has been skew
corrected. For more information, see the note under “To perform manual skew correction
on the currently projected image” (page 103).

1 Press the [FUNC] key to display the YC Camera application function menu.

Use the [¥] key to move the highlighting to “Enhance White” and then press

the [ENTER] key.

® This will enhance the white of the projected image.

® Instead of steps 1 and 2 above, you can also white enhance the projected image by
pressing the [A] key.



To perform manual skew correction on the currently projected image

% Note

® Skew correction automatically straightens the image of a document that is misaligned
on the document stage of the document camera. Under its initial defaults, the YC
Camera application is configured to perform skew correction automatically. You can
also turn off auto skew correction. If you do, you can use the following procedure to
adjust image alignment manually.

® This operation will affect only the image that is currently being projected. The
projection image produced the next time you release the shutter will be projected in
accordance with the settings on the YC Camera Application Setup Menu (page 104).

1 Press the [FUNC] key to display the YC Camera application function menu.

Use the [¥] key to move the highlighting to “Skew Correction” and then press
the [ENTER] key.
® This will straighten the projected image.

® |nstead of steps 1 and 2 above, you can also perform skew correction of the projected
image by pressing the [[J] key.



Configuring YC Camera Application Setup Menu Settings

You can use the YC Camera setup menu to configure various YC Camera application
operation settings.

L, G Camera Setup
Operation Mode @Auto Capture CManual Capture
Monitor Screen Orientation ‘@Harizontal QOertical
White Enhancement O0n W@Off OAuta
Skew Correction @®0n OOff
Project Document Monitor lmage @0n OO0ff
Initialize YC Camera Setup 0K [ENTER]

T e e T
[a]/[¥]:Select [ENTER]:OK [ESC]-Quit

To configure YC Camera application setup menu settings

1 Press the [MENU] key to display the setup menu.

2 Press the [¥] key to move the highlighting to “USB” and then press the
[ENTER] key.

3 Press the [¥] key once to move the highlighting to “Setup” and then press the
[ENTER] key.

® This will display the YC Camera application setup menu.

Use [V¥] and [A] to select the menu item whose setting you want to change.
Press the [4] or [P] key to select the setting you want (so its button is @).
Repeat steps 4 and 5 to configure other settings, if you want.

After you are finished, press the [ESC] key to exit the setup menu.

NO O A~

% Note

Anytime you change the “White Enhancement” or “Skew Correction” setting, the new
setting goes into effect from the next image you record with the document camera after
exiting the setup menu. Other settings go into effect as soon as you exit the setup
menu.



To restore all settings on the YC Camera application setup menu to their
initial factory defaults

1
2

o O

Press the [MENU] key to display the setup menu.

Press the [¥] key to move the highlighting to “USB” and then press the
[ENTER] key.

Press the [¥] key once to move the highlighting to “Setup” and then press the
[ENTER] key.
® This will display the YC Camera application setup menu.

Press the [¥] key to move the highlighting to “Initialize YC Camera Setup” and
then press the [ENTER] key.

® This displays the dialog box shown below.

I E . Initialize YC Camera Setup I

| Do youwant to restore defaults for the YC camera? |
| Yes |
Mo
[a]/[¥]:Select [ENTER]:0K [ESC]:Return

Use the [A] key to select “Yes”.

To restore all the settings to their initial defaults, press the [ENTER] key.
® To exit the operation without doing anything, press [ESC] instead of [ENTER].

After you are finished, press the [ESC] key to exit the setup menu.
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YC Camera Application Setup Menu Contents

This section provides detailed explanations of all of the items included on the YC Camera
application setup menu. The initial default setting for each item is indicated by an asterisk

(*)-

Setting Name

Description

Operation Mode

Specifies whether recording of documents placed on the document stage of
the document camera should be performed automatically or manually.
Auto Capture*:
Automatically records the image of a document whenever it is placed on the
document stage.
Manual Capture:
Requires manual release of the shutter each time a document is placed on
the document stage.

Monitor Screen

Switches the monitor screen orientation.

Orientation Horizontal*:
Records the document on the document stage horizontally.
Vertical:
Records the document on the document stage vertically.
White Specifies whether or not white enhancement should be performed on the
Enhancement projected image.

Off*:
Turns off white enhancement.
On:
Turns on white enhancement.
Auto:
The decision whether or not to perform white enhancement is made
automatically in accordance with the image being recorded.

%@ Important!

White enhancement cannot be performed while the “Skew Correction”
setting is “Off”.




Setting Name

Description

Skew Correction

Specifies whether or not skew correction should be performed automatically
on the projected image.
On*:
Turns on automatic skew correction.
Off:
Turns off automatic skew correction.

Project Document
Monitor Image

Specifies whether or not the camera’s monitor image should be projected
when a document is removed from the document stage.
on*:
Displays the monitor image.
Off:
Does not display the monitor image.

Initialize YC
Camera Setup

Returns all YC Camera application setup menu items to their initial default
settings. For details, see “To restore all settings on the YC Camera
application setup menu to their initial factory defaults” on page 105.
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